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The scientific investigation of Kirlian photography has always been a

contentious issue. Unreliable instrumentation and incomplete documentation

characterized initial research efforts of most investigators. An instrument was

designed and consttucted which addressed these concerns. Using modem engineering

techniques a portable instrument which can take near instant quality photographs was

produced. Important design features include :

• Virtually Instant Pictures - The setup time can be very fast, a specimen can be

ready in seconds

• Complete Digital Camera Control via software

• High voltage and frequency can also be controlled via the software

• Galvanic isolated high voltages which protects the user

• Automated. monitoring and recording environment

Xl



• Offiine/Internet Viewing - It is possible to review past experiments

The product presented in this dissertation makes use ofstandard microcontroller

hardware and software design theory and practises as well as conventional personal

computer PC programming techniques. Standard electrical theory was also applied

throughout to deliver safe and effective device.
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CHAPTERl

INTRODUCTION

1.1 Brief History and Description of Kirlian Photography

Kirlian photography is a novel way of taking photographic images of animate

and inanimate objects. This unique method of taking photographs produces a pattern

of streamers rich in retail sUtrounding the object photographed. An example of this

type of photograph can be seen in figure 1.1 [Johnson, 1975:121].

Figure I-I: Typical Published Kirlian Photograph

This photograph is an examp\' of a typical Kirlian photograph shown in

literarure. The object in this photograph is one of a strawbeny leaf taken by KendaIl
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Johnson in 1996. The high voltage discharge created the pattern, which was captured

by means of an unexposed photographic ftlm.

The discovery of Kirlian photography was made by a husband and wife team,

S. D. and V Kirlian, in 1939 in the Ukraine. It was however only brought to the

attention of westem investigators in the early 1960's [Kirlian, 1963]. Since then, the

investigati:m into this phenomenon has been characterized by rash claims and counter

claims as to the significance of these pictures. However, it is easy to explain in

mundane terms the mechanics involved in taking Kirlian photographs.

Although steeped in controvers y due to its paranormal connections, nothing

out of the ordinary is required to explain what happens when a Kirlian photograph is

taken. In order to take a Kirlian photograph the following method is generally used,

which results in a picture of an electric al discharge between two objects. One of the

objects is an electrode consists of flat piece of metal to which a high voltage source is

applied. The other object is the subject of the photograph. The subject is usually

electrically grounded. The two objects or elecrrodes are normally separated by an

insulating material. The insulating material in a standard Kirlian photography is the

actual photographic film used to capture the image. As can be deuced from the above

description, electrical discharge occurs retween an earthed object and a pulsed high

voltage source [Tiller, 1973:78]. Depending on the potential dilTerence and other

factors a corona discharge, sparks or arc discharges can then be photographed. In rhe

original discovery the photographic film served as rhe dielectric material.

There is however still a major conrro\'ersy in scientific and paranormal

quarters as to v...'hat the details represent. Some tnvestigators insist that it is the so­

called mythical auro. which has been phorographed. While others mamtain [hat 11 [5

just a discharge panem of the ~lecrrical oreakdo\vn. Although this issue IS centrJ! as
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what kinds of practical benefits Kirlian photography will deliver, the answer to this

question is not central to this investigation.

Notwithstanding the fact that there are disagreements as to what is being

photographed, there have been successful demonstrations of the medical diagoostic

ability ofKirlian photography. There are other diverse fields where Kirlian

photography stands to deliver important contributions such as Psychology [Moss,

1981 :26], Psychiatry and Parapsychology (Hossian, 1995:821], Metallurgy [Johnson,

1975:170], Medicine [Konikiewicz, 1979] & [Chouhan, 1989:Abstract] and more

recently "electromagoetic fields associated with billogical systems" [Russo el-ai,

2001]. Although Kirlian photography has been around for almost four decades, these

exciting channels of investigation have yet to be thoroughly researched.

There are several of the reasons offered for the slow progress of reveloping

this technology. Firstly, reliable instrumentation was not always used as it takes

careful engineering to produce stable high voltage source. Secondly, there are many

environmental factors, which if not taken into account during the experimentation will

produce invalid results. Thirdly, because of the above reasons it was and still is

difficult, sometimes impossible to reproduce other investigators results. Lastly, there

were so many unsubstantiated claims made, whether they are true or not, that this

impeded the scientific investigation into the use of this technology.

1.2 Problem statement and motivation

In order for significant progress to be made in the utilisation of the KirIian

Photographic Technique, repeatable and reliable instrumentation is required. The

literature is full of investigations, which at the outset attempted at produce Kirlian

effects often with Olit regard to the standardisation of the photographic process as
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alludedto by researchers [Dakin 1974] and others. This dissertation describes the

design and prototyping of a stable instrument, which will automatically document and

record of most relevant information while taking a Kirlian Picture.

The techniques for producing Kirlian Photographs are quiet well defined.

There are areas of controversy in the literature however, and these relate to the

reliability or repeatability of the instrumentation especially the high voltage source

[Konikiewicz, 1979]. There are other issues such as the interpretation of the

photographs but this will be the subject of further smdy. The focus of this project is to

document the design of a stable reliable instrumentation, which can be used to take

Kirlian picmres. By documenting the design, it is hoped that a number of outcomes

will be aclieved. Firstly researchers of Kirlian photography phenomena will be able

to use the prototype device to investigate reported Kirlian effects with out the serious

concern of the scientific validity of there results. Secondly, other investigators could

use these results to build similar or improved devices, as detailed documentation of

Kirlian Photographic instrumentation is not readily available. With these outcomes in

mind, the design of this Kirlian instrumentation was tackled.

13 Approach Used in the Stndy

The main object of the dissertation is documentation of the production of an

instrument, which can be used in the research of the Kirlian photographic phenomena.

Ideally, a safe, scientific, self-contained instrument with the ability to take instant,

high quality Kirlian photographs should be delivered.

This investigation made use of the following Engineering techniques: High

Voltage Engineering, Digital Photographic Techniques, Analogue Data Collection,
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Microprocessors and Object Orientated software design. Standard design issues were

addressed like the ease of use, availability and cost of components. More than this

however thorough use ofmodem technological advancements was incorporated.

Bearing in mind that most Kirlian instrumentation was designed before 1980 there

were ample opportunity to improve on the traditional Kirlian photographic designs.

1.4 Outline of this Dissertation

The selection and measurement techniques employed to monitor the

environment conditions are described in Chapter 2. This is a relatively straightforward

approach to address to some extent the concerns ofcritics that environment conditions

are important when evaluating this phenomenon.

In Chapter 3 the actual modalities of taking Kirlian photographs are discussed.

A non-traditional method based on the transparent electrode technique is described as

well as the digital camera techniques that are finally employed in this device.

The key area of performance issues relating to the generation of high vo ltages

is discussed in Chapter 4.

A microcontroller system was designed to clrOrdinate data transfer between

Kirlian device and the Pc. This system is described in Chapter 5. Using a

microcontroller facilitates the scalability of the instrumentation, as it will be easier to

add new functions and features later as required.

Incorporating the processing and presentation power of a modem PC with the

interfacing of a microcontroller resulted in a design that seamlessly adds most of

functionality expected in modem instrumentation. Using the PC program, described in
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chapter 6, gives the researcher a much more control over the process of taking an

experiment and thus easier for him or her to document and study the results.

Integrating the various systems to JToduce a working device is described in

Chapter 7. Details for the power supplies and other constructional are also

documented here.

Chapter 8, details the performance of the device. A walk through of an actual

experiment and its eventual Kirlian pictures and data is described. Implications for

human subjects are also discussed.

Finally, the inferences that can be drawn from of this dissertation discussed

and concluded in Chapter 9.

1.5 Delimitations

The study will limit its investigation to the reproduction of high voltage

photography and will not in any way presuppose what the actual photographs

represent

There were certain practical limitations which had to be dealt with. These

were limited to the folIowing. Ideally, controlling instead of monitoring the

environmental parameters would increase the effectiveness of the instrument. This

would however add greatly to the cost and complexity of the instrumentation.

In the similar manner monitoring of additional environmental factors could

impact on the repeatabiIity of pictures or reveal other modulation factors. These other

factors include but are not limited to:

I. The ionisation potential of the atmosphere.

2. The composition and quantity of gasses in the atmosphere.

3. Surface conductivity of the sillject.
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1.6 Publications

Letters emanating from this research was published in the accredited joumals

listed below:

1. Electra Photographic Instrument for Use in Kirlian Photographic

Phenomena Research. Published in Quantum Test & Measurement

[Wil1iams & Khan, 2003].

2 Implementation ofa PC and Embedded Microcontroller Based Data

Acquisition System for a Corona Visualization Device.

Submitted to ACTA Press for publication in the "International Journal

ofComputers and Applications".

A conference IDster entitled ';4 Monitoring System for Environmental

Parameters impacting on Corona Discharge Visualization" was presented at the Cape

Biotech 2003 Conference



CHAPTER2

SELECTION AJ.~ MEASUREMENT OF ENVIRONl\lIENT PARAMETERS

2.1 Introduction

In this chapter, the issues surrounding the environmental parameters are

discussed. This task required selecting, from numerous possibilities, environment

conditions to monitor. This approach was taken to address concerns of critics that

environment conditions are important when evaluating this phenomenon. It has been

argued that no valid interpretation of the result can eke place without the due

diligence of the environment. (peheket-al, 1976].

2.2 Selection of Conditions to Monitor

Many parameters known and possibly unknown, affect the detail of a Kirlian

photographic picture, for this reason careful attention to the environment is required.

To ascertain which parameters will be of significance to this device two a lines of

investigation was embark upon. Firstly, an extensive interview with a leadingexpen

on Kirlian photography in South Africa was carriedoul. Secondly, the published

literature on this subject was consulted.

8
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23 Interview with a Kirlian Photographic Expert

On the 3rd of August 1999, an interview with Ebrahim Hossian of Medunsa

was carried out As leading expert in the field, he gave the current research new

direction [Hossian, 1999]. One of the fruitful lines of investigation suggested was the

reduction of the enviromnental variables to be monitored. As a result of this interview

and reviewing the literature, the following five parameters for measurements were

selected:

1. Ambient Temperature:

This can be considered a universal measurement parameter. Almost all

physical phenomena are influenced directly or indirectly by

temperature.

2 Atmospheric Pressure:

The corona discharge are influenced by atmospheric pressure

according to Paschen's Law hence its inclusion as an enviromnental

parameter to be measured.

3. Ambient Light Level:

Its imperative that any picture taken should arise due to the Kirlian

effect, therefore this measurement is chosen to make certain there is no

contaminating light.

4. Humidity:

Electrical Phenomena in general and corona discharges specifically are

affected by the amount of moisture in the air.
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5. Pre ssure ofthe object:

The pressure of a specimen on the dielectric medium in most cases

directly affects the surface area exposed to the high voltage system and

thus the resultant picture.

Other possible candidates for measurement were excluded because ei:her

because it has minimal impact on the picture or because they were too complex to

implement in practical terms. The measurements excluded are:

1. Ionization potential:

The amount of cbarged particles in the air could most like effect the

resultant picture. It was however not considered as it was to complex to

obtain a significant reakime measurement of this parameter.

2. Angle of object with respect to the dielectric medium:

This parameter definitely affects the Kirlian photograph. It was not

considered as it ouly pertains to finger tips photographs and was

considered superfluous at this stage of this design.

3. Surface conductivity ofthe object:

The surface conductivity of certain subjects such as people will most

probably be effect resultant photograph. Again this was too complex to

measurement to perform with this "proof of concept" device.

4. Qualitative and Quantitative composition of atmospheric gasses:

The distinctive blue colour which is characteristic of most Kirlian

photographs is the result ionization of molecules and atoms of the

atmosphere and then the subsequent recombination of the ions and

electrons [Dakin, 1975J therefore composition of the surrounding



11

gasses directly affects the photographs. Needless to say that these measurements

were not incorporated in the device presented

2.4 Measurement Circnitry Implementation

A design feature of the instrument allows the straightforward inclusion of up

to four additional environment parameters, provided the sensor and supporting

circuitry supplies a linear 0 to 5 Volts in response to the measurand. It is perfectly

conceivable that biometric data could also be included amongst these additional

measurements.

2.4.1 Temperature Measnrement Circuitry

The temperature circuitry employs a standard LM35 integrated sensor. The

circuit diagram is shown in Figure 2-1 below. This sensor uses the effect that the

difference in voltage between two transistors operating at different current densities

are for the most directly related to the temperature of the transistors in Kelvin

(National Semiconductor, 1986). The LM35 develop these characteristic to provide a

stable, accurate and reliable temperature detector which output is directly related to

the temperature in degrees Celsius.
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TEMPERATURE
SENSOR

Twisted PJir -*24LM35

coIr use O)u 1

-'-// .m,. "",., , Ok

I ~:a 200

RW

"

o

Figure 2-1: Temperature Sensor Circuitry

The circuit conforms to the two wire remote sensor configuration published in

the National Semiconductor Application Note (National Semiconductor, 1986). In this

configuration a single pair of twisted wires delivers the power to the sensor in

addition to providing the signal to the operational amplifier. The operational amplifier

is in non-inverting mode and operates from a single supply voltage of +5Y. The

output of sensor in this configuration is IOmV per degree centigrade with DOC

providing DV. The circuit operates with a voltage gain of 6 calculated as follows:

VoltageGan _R""_+_R--",,-o = 6
RIO

(2.1 )
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2.4.2 Humidity Measurement Circuitry

This m~urement circuit consists ofa Siemens capacitive humidity sensor

aod supporting circuitry. The sensor consists ofthio-fihn polymer membraoe aod has

a near lioear response to humidity from 10% to 90% RH (relative humidity). See the

relevaot data sheet (Philips: 1997).

Three integrated circuits are employed to perform this measurement. The first

stage consists ofLM7555 is in astable mode. The sensor forms part of the main

frequency generation ladder. This timer outputs a frequency inverse ly proportional to

the ambient humidity, according to the following equation.

1.44
f-~---"--

- (R, +2R,1:.

where f is the frequency out

Ch is capacitance ofthe sensor

both RI and R2 is 330KO

(2.2)

Extrapolating the mirtimum aod maximum capacitance values from curves in

the data sheet gives us values of IlOpf aod 15Opfrespectively. Using these values in

equation 2.2 this gives us a minimum frequency 9696 Hz of aod a maximum

frequency of 13222 Hz respectively. The output of this timer was then taken straight

to that of the frequency to voltage converter.
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VO"' = J.. x 2.09 x ~L x (R,C,)
s

(2.3)

where Vout is output voltage ofthis stage

fin is the inputfrequency

RL is RIO it value is lOOk

Rs is R6 it value is 15K

R, is R7 it value is 6.8K

C, is C3 it value is IOnF

+10.

, .,.,
33k

,
~R14
,22k

,,&GND

J.,
R3 R7,'" .5 LM331 O.8K

U1 l.MOO5

~I
,'" U2

, - , ~

,
• Ii, ,eA..me.1 470Pf

n.&. t-'-
,
~ - ,

• n~u

U ,.L
O~~ r>- r--'-

, -'-~.. .4 ~ 0 ...
0 ... R6 RlO

,5> co C. 100K=:= H1 C1 'On T1u
T1011

WIOITY J..GND
NSOR

1
R12

:27k
R11

= ,
lJ3A

HU
SE

R2
33llk

R1

33llk

Figure 2-2: Humidity Measurement Circuitry

The output of this stage varies from 12.5V to 9.2V according to the above

formula. A voltage follower buffers the next stage which is a difference amplifier.

Selecting the correct values for the difference amplifier was done as follows:
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Gain required 1.5; calculated from 5V/(12.5V - 9.2V).

Offset adjust required 13.8V; the minimum value of 9.2V needs to be subtract when

amplified by 1.5.

(
Rll +RI2 )R14 RI2

V = -v --v
00' R13 +RI4 Rll i. Rll 'Of

(2.4)

where Vout is output ofthe difference amplifier

Vin is the input from the voltage-follower stage

Vrefis a reference voltage coming straightfrom the 5 volt supply line

RIl va lue is lOk

Rl2 value is 27k

Rl3 value is 33k

R14 value is 22k

Applying the fixed values to equation 2.4 results in the following:

Voo, =1.48 x v,. -13.5V (2.5)

This difference amplifier conditions the signal to be in the range of D.12V to

5V, according to the formula above [National Semiconductor, 1980]. This output was

then delivered to the analogue AN3 input.
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2.43 Light Measurement Circuitry

There are a number of measurement criteria when it comes to the formal

process ofmeasuring light levels. I t is sufficient of this investigation that the

measurand required is that of illumenance . The SI unit of illumenance is the lux

which is expressed in units oflumens/m'. These units refer to the response of the

human eye; however the equivalent detector units would be that of mW/cm'. The CIE

standard ofluminosity, often called the standard eyeball relates the two units

[Squillante & Shah 1999].

-15V

if.

'f +15V

AN2

U1D

LF444 Ouj>-,,'4,---~p- -@

1J

11

;-----'V'Ar------"
R2 100k

-15V

,
U1C

LF444 0

10

J
+

~D1
+15V

I
PHOTOOICDE"1

I,

Figure 2-3: Light Measurement Circuit

The light intensity could vary drastically, this is because the instrument could

under some conditions can take pictures even if the lid was open therefore it would be
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ideal to display the light intensity values over a large scale. Very opportunely, the

eye and photodiode detectors in an open circuit voltage mode respond logarithmically

to light intensity, therefore the measurements are calculated and are displayed in this

form. Straightforward circuit produces the signal we require see Figure 2-3. The first

stage voltage follower input op-amp which ensured the diode is not loaded and thus

open circuit voltage mode in ensured. According to the datasheet of BPW21 PIN

photodiode of Infineon a light level of 8 Lux produces an open circuit voltage of 250

mV at the low-end of illumination scale whereas a light level of 2000 Lux produces a

voltage of450 mV at the higlrend. The next stage is simply a non-inverted provides a

gain of 11. This output was then delivered to the AID input AN2.

Note that 8 Lux is minimum detectable light level of the BPW2l due to "dark

currenf' swamping the signal at lower levels. A better PIN diode, such as the BPX63,

would improve the detection limit, however dar1<-currents is a problem intrinsic to

photodiodes technologies and is not easy or possible to reduce it completely.

2.4.4 Barometric Pressure Circuitry

The SI unit of measurement of pressure is the pascal (pa) whereas the

barometric pressures (P Bl or ambient air pressure is commonly measured in

millihars. There is linear relationship of 1 millibar to 100Pa between the two [Heeley,

1996]. Barometric pressure can change from about 940mb to 1060mb due to weather

conditions alone.
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Figure 2-4: Barometric Pressure Circuitry

The two significant areas where barometric pressure measurements are

required are in the meteorological and aviomcs industries. As the weather and altitude

each significantly iropacts on barometer readings this makes their iroplementation in

any these domains reasonably complicated. For our purposes however we are only

interested in the absolute air pressure therefore considerably simplifying this

measurement The circuitry employed is based partially on the Motorola Application

note AN1326 [Winkler & Baum, 1997].

This measurement was accomplished by using the Motorola MPX2100 silicon

piezoresistive pressure sensor. These devices are manufactured in difference

configurations. The version used was the MPX2100AP, which features temperature

compensation, absolute measurement, and a single measurement pon. The maxiroum

change in pressure due to reasonable altitude change and weather conditions is 24 kPa

this corresponds to winters day at level (Cape Town) to a summer's day in

Johannesburg at l200km altitude. This will produce a voltage swing of 24% of full-

scale swing (40 mY) or 9.6 mY. In order to have full-scale del1ection at the A to D
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input (5 V swing). The gain should be in the order of 5/0.009.6 or 520. The elements

of this sensor are arranged in bridge formation. Using a classic instrumentation

amplifier design a gain of 520 can be achieved with RI~R3 = 120 0 and

R2=R4=620KO. Note calibration of this device has not taken place thus far.

2.5 Software Monitoring Aids

The initial device specification, calls of a monitoring system which would aid

the operator of the device when performing Kirlian photographic experiments. The

computer program was designed in such a manner as to provide an "Experimenters

View" that is; all the information and details pertinent when taking these photographs

are provided to the operator. Figure 2-5 below shows the absolute maximum and

minimum values of the alarm limits, thus all the measured variables are within limits

and are shown in green. Whereas Figure 2-6 depicts the practical implementation of

alarm limits with two measured variables causing alarm conditions. The first alarm

condition that oftemperature, which is measured at 19 degree Celsius whereas the

limit is 10 to 16 degrees, thus the emphasis on 19 in the panel. The second alarm

condition shows humidity at 40% RH whereas the limit for this experiment is 45% to

60%, thus the emphasis on 40 in the panel. An additional GUl feature is that the

colour of alarm indicators gives a visual clue as to whether the specific environment

variable is above or below the alarm limits. Note the sensor system to measure object

pressure was incomplete and therefore the acronym NlY (Not Implemented Yet) was

used.
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Figure 2-5: Environmental System Showing AbsolUle Limits

In addition to having all !be data available two other invaluable resources is

made available namely:

I. The operator can store an "Expeiimenl Profile". This is all the applicable

infonnation required when taking a Picture and the ability to recall that data to

reproduce tbaI particular experiment.

2. The operntor can also set high and Iow aIann levels ofany of the measured

variables. This reature ifcorrectIy utilized can further ensure tbaI reIiabIe

experimemation takes pIace.
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Figure 2-6: Enviromnent Variables Showing PIlIctical Limits with Alann Conditions

The initial settings oftbese alarm settings do nol prevent an operator from

talcing a picture but simply warns him that the tolerance of the particular

measurements is in question. and is most likely out of bonds of his experiment design.

As a method of guarnnteeing the COIISistence of the experiment profiles, these limits

are stored sep:uately with each experiment's data.

2.6 Conclusion

The measurement of the environmental paIllDleIers although not inhibiting to

the operation of the device it is critical in terms ofproviding scientifically valid

results. careful attention to the details of the measurements and its associated systems

has to occur if any significant conclusions are to be drawn from the results. As shown

above it is reasonable to assume that as other significant measurement panuneteIs are

discovered they could readily be added to this preliminary KirIian device or 10

subsequent designs.



CHAPTER3

TRAJ.'!SPARENT LIQUID ELECTRODE TECHNIQUE WITH CCD
IMAGING

3.1 Introduction

The original method of taking Kirlian Photographs involves using

photographic film as the dielectric material between the subject and the high voltage

source. Excellent quality pctures can be obtained using this method as there is no lens

or camera involved in the process. There is however many limitations when using

this direct contact method, these include but not limited to the following.

3.1.1 Darkroom Film Processing

The photographic film must be handled and processed in darkness during the

entire process of taking a Kirlian picture [Iovine, 1993]. That means either a darkroom

for black & white film or near total darkness for colour film is required. There are

other techniques which do not suffer this limitation but the y introduce other concerns

these include the quality of pictures and other handling constraints. These techniques

include keeping the unexposed tIlm in a light tight envelope and then using this

22
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envelope as the dielectric medium yet another technique uses fax or thermal ink.

paper.

3.12 Film Size

The developed film size is limited is particular photographic developmem

system available. A normal automated laboratory processing of colour film is limited

to 5 by 4 cm prints.

3.13 Film Flatness

Thirdly, special care must be made to ensure the film remains flat when taking

the photographs. If this is not assured, the pictures will possibly show colour anefacts.

[Tiller: 1975]

3.1 A White Balance

Lastly, ifpositive prints are used special care is required to insure that the

white balance is set correctly, if not set correctly the colour purity of the photognlphs

will be compromised.

3.2 The Transparent Electrode Defined

An alternate method of taking Kirlian Photographs involves the use of a 3()­

called transparent electrode. This method was most likely first proposed by Leonard

Konikiewicz in the seventies [Konikiewicz, 1977]. This is simply a glass p!aIe that is

electrical conductive on one side. The operation of elecrrode involves connecting the

conductive side to the high voltage source. The object to be photographed is placed
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on the nOIrconductive side. When the high voltage supply is switched on a discharge

occurs between object through the glass to the high voltage source. This discharge is

then photographed through glass plate, which allows the use of ordinary camera to

take a Kirlian picture.

There are a few of things to be aware of before applying this so called

transparent electrode technique.

3.2.1 Film sensitive

Firstly, because of the low levels of light emitted, the camera or the film needs

to be sufficiently sensitive.

3.2.2 Macro lens

Secondly, to reduce dispersion of light, the camera needs to be as close to the

electrode as possible therefore some sort of macro lens capability is required.

(Photographic professionals regard a macro lens as a standard way of taking close-up

photographs).

3.2.3 Manual or long exposure times

Thirdly, if the photographic film or CCD is not sensitive enough, longer

exposure time will be required. Normally a manual shutter mechanism is required to

achieve extended exposure times this is typically referred to as the hulb setting in

photographic circles. As states previously, a dramatic increase in the exposure time

would decrease the sharpness of the image [Iovine, 1993].
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3.2.3 Protection of conductive layer

Ifa conductive glass sheet is used, care must be taken to prevent localized hot

spots destroying the conductive layer.

When all these issues above are adequately addressed, as it was the Case in this

investigation, this technique suffers none of the debilitating issues described in the

introduction of this chapter.

3.3 Construction of the Transparent Liquid Electrode

Sourcing of a conductive transparent glass sheet proved difficult, as there are

no known local suppliers of this product. Homemade versions of this product do

prove to be some what unreliable as the coating tends to be easily destroyed if there is

a strong local discharge. Due to the unavailability of a conductive transparent glass a

Transparent Liquid Electrode (TLE) Was designed and constructed. See Figure 3-1

below for details of this construction. This electrode consisted of an opaque plastic

PVC frame with a 3mm glass sheet glued to one side and a 2mm glass sheet on the

other side. This mechanism resulted in a thin hollow sandwich be ing formed. A small

tapped hole was drilled in one side to allow the sandwich to be filled with electrolyte.

The electrolyte used was common table salt (sodium cWoride) dissolved into distilled

water. In the first electrode, a concentration of five grams per litre was used. It was

found that the concentration of the solution is not critical. The tapped holed was then

sealed with a matching stainless steel Screw which was long enough to make contact

with the electrolyte to provide a path to the high voltage supply. Diffetent thickness of
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glass sheeling was used, to allowing the research to observe in any difference in

pictures using them alternately as the dielectric medium.
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Figure 3-1: TransIBfent Liquid Electrode Construction

Side View

This electrode has added benefits of been practical immune to hot spots as

well as relatively inexpensive to construct.

3.4 Initial Kirlian Photographic Experiments

A proof of concept experiment was needed in order to prevent a situation

where a lot of work is put into the proposed instrument only to find out later that there

is something flawed in the photographic system or the original assumptions. It was

decided to construct a test rig that will evaluate the basics of the photographic

subsystem. This test rig consisted of the following components:

• A Transparent Liquid Electrode (TLE)
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• A laboratory insulation tester with an adjustable high-voltage supply of

SOOOV to 30 OOOV at fixed frequency of SOHz

• A single lens reflex (SLR) camera, Nikon FSO

• A freshly cut leaf which served as the subject

• And a wooden block sprayed matt black to support the subject and TLE

These components were arranged in a dark room of the Electrical Engineering

department The subject was placed the block ofwood. The wood served as an

insulator between the subject and the floor. The transparent electrode was placed on

top of the subject. The camera mounted on the edge of the bench was focused on the

subject

The initial results were not promising as most of the pictures were "washed

out" due to overexposure or black due to insufficient light from the subject. Once this

was compensated for, by reducing the exposure time and increasing the speed of the

film satisfactory results was obtained see Figure 3-2 for our first successful picture.

From the experience obtained from these trail runs it was decided that our

assumptions about taking Kirlian Photographic pictures was correct and it is with in

our capability to complete the project as specified. It is important to note that the

device designed and constructed in this research, routinely takes pictures of this

quality and better with the environmemal data automatically captured and with out the

need of a darkroom.
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Figure 3-2: First Successful Picture with a Test Rig

3.5 Selecting Camera Technology

The TLE teebnique allows any conventional camera to take Kirlian

photographs. Therefore a decision as to which camera technology would be suitable

was required. Techniques exist which can take pictures without the use of film and its

associated development processes. An obvious example of this is digital camera
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technology. Ifdigital camera technology could be used this would bring tremendous

advantages over the traditional method of tal<ing Kirlian photographs. A decade ago,

this technology was not really an option for tal<ing Kirlian Photographs as it was too

expensive and the quality of the pictures was unacceptable. Today with the rapid

increase in technology, it has become possible to consider digital cameras as a means

of taking these pictures.

Some of the benefits of using digital camera include, no darkroom processing

with its associated consumables and near instant rendering of the photographs.

Another advantage of digital technology is that pictures can effortlessly be transferred

to a computer. Using this technology for this project has meant that no scanning in of

pictures is necessary as the Kirlian Experimenter software automatically captures

them. This study is not the flISt to successfully use digital camera when taking Kirlian

photographs, however published information surrounding this application is very

scarce indeed.

There are limitations to the use of digital technology. Ordinary film cameras

still provided better quality pictures than CCD or CMOS based digital cameras.

3.5.1 Evaluation of CCD Camera Performance

There are four main characteristic or features required by a Digital Camera or

any other camera for that matter, to take Kirlian pictures using the transparent

electrode technique. These features are listed below:

High Sensitivity The first requirement is sensitivity of the camera needs to be at

least rated at IS0400 or else the exposure times required will

produce ill-defined pictures.
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Manual Shutter The ability to control the shutter speed of the camera

externally. Mainly to achieve exposure times up to 15 seconds.

Short Focal Length The ability to focus at a short distance, 30cm or even shorter.

This capability is usually document by camera manufactures as

a camera that has a macro feature.

Large Aperture This allows the maximum amount light from the subject onto

the CCD. This is more usually specified by the F-8top number

of the lens. The lower the F-Stop number the larger the

aperture. An aperture setting in the region of 2.0 is suitable.

The relationship between the sensitivity, shutter speed and aperture settings for

a particular light level is commouly referred to as the exposure setting of a particular

camera setup. Idealy, for a given amount of available light from a subject there are

myriad combinations for these three settings. For example, one could increase the

aperture setting to compensate for decrease sensitivity of the film or CCD. Another

scenario allows a more sensitive the photographic device to take picture with a slower

shutter speed. A good quality camera operating under normal conditions would allow

the aperture to decrease while increasing shutter speed. The net result of this is the

exposure remains constant. However when taking Kirlian pictures most cameras will

be operating at the very limits of their sensitivity and will not have much leeway in

adjusting its exposure values. Careful consideration of the detection limits of the

digital camera is required w hen attempting to take Kirlian photographs.
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To observe whether suitable results can be obtained with CCD devices a

video camera and CCD camera was used in similar trials. The first budget consumer

CCD camera failed this trial as its sensitivity was ouly rated at an effective ISO100

and it shutter speed was only adjustable to a maximum of 33ms. The video camera

was able to take recognizable Kirlian photographs because it hadthe relativity uoique

feature ofa slow shutter speed settiog of about one second and the sensor was based

on CMOS technology. Unfortunately, the quality of pictures produced by the video

camera was inadequate. As can be deduced the quality of pictures depends nearly

exclusively on these exposure characteristics as well as the sensors resolution.

Therefore it was important to have these trials as it showed which cameras or devices

would be suitable to be included into the Kirlian device.

3.5.2 Digital Camera Selection

The process of selecting an appropriate digital camera was, in a sense, made

easier by the numerous specific features required by this project. Firstly, budget

constraints limited the choice to be made from the so called "prosumer" range of

cameras. This range is known, industry wide, as products which falls, in rna rketing

terms, between that of the professional and consumer ranges. Secondly, the

photographic requirements which are listed above do severely limit the choice.

Thirdly, electrical and mechanical compatibly was an issue as it was a requirement to

control the camera from a Pc. A shon list of cameras which would fit the

requirements was drawn-up. Key advantages and disadvantages is listed see Table 3-1

below.
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Table 3-1: Digital Camern Short List

Digital Camera Advantage Disadvantage

Sony Good all-round capabilities Dubious PC control abilities.
.

Olympus C4040 Z Excellent all-round capabilities Limited Macro features

Fuji Film Very good low Light capabilities Aperture settings limited

Expensive.

The superior aperture settings as well as its high CCD pixel count (4.1 Mega

Pixels) clinched the decision in favour of the Olympus camera. It is possible that the

other candidate cameras could perfonn admirably but that is not relevant in this

discussion. It is important to be cognizant of the fact that major manufactures of

digital cameras release superior products approximately every 6 months.

3.6 Conclusion

The TLE technique together with the using modern digital imaging techniques

introduces unique modaIities for taking Kirlian photogrnphic pictures. Moving this

technique from the darkroom literally and figurntively introduces exciting new

avenues of investigation.



CHAPTER4

THE IDGH VOLTAGE SUPPLY SUB-8YSTEM

4.1 Introduction

The Kirlian photographic device should have a stable high-voltage supply for

results to be scientifically significant The initial design specified a high-voltage

supply with the following feltliles:

1. Adjustable voltage output from about 4 to 20kV

2. Adjustable pulse repetition rate of about 50Hz to100kHz

3. Able to source current of 5mA

4. The adjustable parameters should be able to be configured digitally.

5. Galvanic isolation of at least 2kV between the controlling

microprocessor and high voltage generation circuitry

4.2 Topology Selection

The specifications listed in the introduction proved to require a more elaborate

solution than was first expected.. The requirements listed cannot be easily solved by

conventional design theory because of two main reasons. Firstly. the relatively wide

frequency range required.. Secondly, the unknown loading factor of the subject

introduces funher complications. This is discussed in section 4.3. Nevertheless,

progress was made in selection and initial constrUction of a solution.

33
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Various designs topologies were considered these include voltage

multiplication systems such as Cockcroft-Walton and simple StepUp High Voltage

transformers. It was made clear. from an earlier investigatioo,!hat tile ftybIck

converter topology would be most suited to tile solution required The ftybIck

converter is a tmdjfjed buck-boost converter wi1h transfonner-coupled output. The

transformer acts the common inductor between tile two main current loops in a typical

bueJr.boost circuit. It would be more descriptive to call tile transfooner a "two

winding inductor". Most often it is simply called tile "tIybad transfmner".

Figure 4-1 : High-Voltage Coils: The LOYf and the Autotrnnsfonner

Commercially. flyback transformers can be found wherever high-voltages are

required. Two mature applications areas rely on this method almost exclusively wben

genernting higb-voltages. These applications are the driving ciJl:uitry for cathode ray

tubes (eRT's) and for producing sparl<s in petrol combustion engines via an

autotransformer. See Figure 4-1 for examples of these coils. The term "300"­

transforma- can have dual connotations; firstly it is used in the "auto" industry and

secondly. in the electrical sense it is an "autotransfOl1lle!"" since the primary and

secondary winding has one common terminal. This text refers to its electrical meaniJg
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unless noted otherwise. The term LOPT or Line Output Transformer is frequently

used to describe the flyback transformer driving a CRT.

Designing and building a transformer from scratch was not considered as it

would be beyond our level ofskill and expertise as the high-voltage winding would

consist ofmany accurately spaced turns of very fine wire, See Table 4-1 for a concise

comparison of the two types of coils considered.

Table 4- I: Comparing LOPT with an Autotransformer

Parameters LOPT Motor Vehicle Autotransformer

Primary Voltages 50V to IOOV 12V - Nominal

40V - Maximum

Frequency ranges 10kHz t0500kHz 50Hz to 10kHz

Output Voltages 12kV for Monochrome 15kV to about 30kV

to 30kV for Colour

Output Current IOmA Up to 20mA

Advantages • High Operating Robust

frequency Easy to work with

provides a more

pleasant

expenence

• Well defined

electrical

specifications

Disadvantages Sensitive to over • Latent capacitance can produce

voltages an unpleasant "shock"

• Unknown constructional

materials used

In engineering tenns the superior coil would be the Line Output Transformer

(LOPT) used on a colour television set, because of its well defined electrical
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characteristics however there could be low frequency applications which would

better suit the autotransformer [Schroeder, 2001] & [Sliwczynski & Krehlik, 1998].

Although the final version of the instrument was constructed with the LOPT, it is a

relatively simple procedure to swap coils as the final drive stage uses the same

electronic circuitry. When swapping coils however the high-voltage circuitry will

obviously need recalibration.

4.3 Flyback Converter Theory

The basic principle of generating high voltages by the so-called "Flyback

method" relies on switching a current in a large coil off. By magnetically coupling

this primary coil to a high voltage secondary coil, substantial voltages can be

generated

It is important to note that in this configuration that there is no voltage per turn

balance between the two windings that is;

4.1

The voltage generated at the primary is governed by this equation:

Vo =-L8I 1ST 42

Where Vo is the voltage produced in Volts;

and L is the inductance ofthe coil in Henry's;

and dI is change in current measured in Amps;

and dT is the period over which the change occurred in Seconds;
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The circuit can be effectively be modelled by substituting the flyback

transformer with an equivalent circuit consisting of an ideal transformer in parallel

with the magnetizing inductance as shown in Figure 4-2. Classic al theory would

suggest that operating the flyback transformer in continuous mode would be a

possible solution as in this mode the Qutput voltage is directly proportional to the duty

cycle and turn ratio. This mode would have the added advantage of low output

impedance [Erickson, 1997:45]. Unfortunately, the current requirement on the

secondary side, which dictates whether this continuous mode is in effect, would be

impractical. Therefore, the non-linear, discontinuous mode of operation was chosen.

This mode has the disadvantage of high output- impedance as the output is load

dependant. An important feature of the discontinuous mode was however used to

good effect namely that the output voltage is also a function of the input voltage

[Erickson, 1997:36]. This fact was used to modulate the output voltage. See section

4.5.

2 <:=:J-----------'-------"
IDEAL TRANSFORMER

TURNS_RATIO 1:N

Figure 4-2: Cantilever Transformer Model

4.4 Practical High-Voltage Circuitry
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This circuit description will trace high-voltage generation back through to the

source. See the complete implementation of the high-voltage circuitry in Figure 4-3.
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A high-voltage fast-switching NPN power transistor Q2 was chosen as the

switching device as supposed to a MOSFET because the flyback pulses regularly

reach 1200 V peak, allowing for margins we needed a device which can withstand

l500V. There are few or nO FETs available for that voltage range. The transistor used

was the BU508A with maximum colIector-emitter volage is rated at 1500V.

A high-voltage avalanche diode D2 was used to protect the switching

transistor. The diode used was the BYW96E rated at 1000V. A snubber circuit could

also be used to perform this function it would require more analysis however ani its

operation would be frequency dependant A power MOSFET IRF150 labelIedMl

was used to drive power transistor Q2, since the current gain of Q2 is only 3 at

required output current of 3 Amps. Using a Ml in this fashion means that it is easily

driven from the frequency source which is the 555 Timer. A photograph of the

practical implementation of this circuitry is shown in Figure 4-4.

The BCI09 transistor QI performed a very important switching function; it

either allowed or disallowed the frequency source, discussed above, to drive the

MOSFET M 1. Q I could be turned on from two different sources the first being an

onboard switch used during debugging or more importantly the exposure signal from

the microprocessor. The exposure signal was isolated by means of an opto- isolator U4

aided by transistors Q5 and Q6.
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Figure 4-4: High-Voltage Supply Practical Implemelllalion

The path of the ftequency source consisted ofan opt<>-isolator U3 as weU as

three op-amp stages UIA. UIB. and UIC. Briefly, U3 isolated the frequency

generation from its microprocessor source. Op-amp UIB formed a comparator to

ensure the correct level ofsignal is picked-up, as the output transistor was in common

base mode to increase the frequency response. Capacitor Cl, Resistor R6 and Diode

Dl integrated this signal which ensured only the rising edge was amplified via UlA.

A comparator stage formed with UIC to p£ovide a clean negative going spike to

tri~ the monomble formed by the 555 timer U2. The monostable provides a

c-onvenient way of adjusting the duty cycle.
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Modelling of!be high voltage circuitIy using !be autoIIansformer was

attempted using PSpice. The result from !be model could not bowever be recoociled

with real world measurements. The PSpice model considered required values which

were unknown For example the effective air-gap length and as well as obscure

materiaJs parameter such as domain anisotropy were UIIObIainabIe [Tuineoga, 1988].

OIlIer researchers had 1imited success with this sjrn,datjQO using tbeir own modelling

techniques [Schroeder. 2001].

Verification of!be 0U1pUl voltage was achieved by using a custom designed

voltage divider circuit as shown in Figure 4-5 below. No allowance was made for

capacitive effects. A 999 mega ohm and 1 MO resistor was used series.

R1
99SM

JIicll I : , 'nee Jo.aaJcc
M. l

R2
1M

Figure 4-5: High-Voltage Measurement Implementation
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4.5 Flyback Supply Circuitry

This circuitry supplied the positive terminal of the LOPT (traditionally noted

as its B+ voltage) with a selectable voltage. The supply was based in main on the

LM723C voltage regulator IC of National Semiconductor and a traditional

unregulated supply consisting of a 150VA transfonner 1XI, a bridge diode pack DJ

rated at 3A and smoothing capacitors C I and C2. Refer to Figure 4-6. The negative

supply rail was not used. The LM723 was configured to allow a series transistor Q I

to pass most of the current. The current was limited to 3A detemrined by R2.

Q

"
"

UI'12JC C,

., "
'" Go!

,<Ell

"

8RIDGE

~'lil-------' "'
J

42VU~ ,--r---r--r---=
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Figure 4-6: Circuit Diagram of the Flyback Supply

Voltage selection is achieved by switching four Printed Circuit Board (PCB)

mounted rela ys. These relays individually select 4 resistors which in turn determine

the voltage output of the regulator. Four digital outputs (ADl to AD4) from the

microprocessor are buffered ,ia BC109C transistors Q I to Q4 before driving the
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relays. Using PCB relays in this manner result in the automatic galvanic isolation

between the microcontroller and the high-voltage circuitry.

The voltage range of this supply is from 7V to 36V in 16 discrete steps.

Calibration of this supply was dependant on the accuracy resistors in the ladder

network. A mechanism to prevent this supply from sinking current from the higb­

voltage trigger circuit was not complete. That is why the practical minimum voltage

was JOV.

4.6 High Voltage Isolation Mechanisms

The production of high voltage is almost always accompanied by various

electromagnetic inferences. These include low to mid-frequency radio waves and

induced voltages by means of capacitive or inductive coupling. In addition analogue

measurement systems are also susceptible to ground loops [Hoover & Rempfer,

1988]. Even more significantly Personal Computer's switch-mode power supply and

very fast switching (up towards I pico.,;econd and faster) produces a significant

number of electromagnetic noise. The PC itself is also susceptible to external noise

sources.

Given the above compatibility issues, it would be prudent to isolate the various

systems. Galvanic isolation was chosen to pre-emptively avoid these issues. The only

other major source of noise to be concerned about would then be that of radio

frequency interferences. Fortunately it is relative easy to electromagnetically separate

the systems for the appropriate frequency range. In practical terms the galvanic

isolation of 3750V was achieved between the high voltage circuitry and the
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microprocessor by means of the 4N25 opto-isolators by Vishay Semiconductors and

Giinter PCB relays.

4.7 Conclusion

Careful design was required to produc e stable high voltage supply. The

propose d solution represented in tbis chapter can only be regarded as an initial attempt

at this reasonably difficult engineering problem. This design requires attention to

proper calibration.

A further enhancement would be to design a supply witb a built-in feedback

mechanism as tbis would negate tbe problems associated witb high output

impedances. The final product delivered an accurate output voltage of approximately

5% over tbe required scale on a fixed load resistance.



CHAPTER 5

HARDWARE AND SOFTWARE OF THE MICROPROCESSOR

5.1 Introduction

The Kirlian photographic device requires a system which would facilitate

communication of device setting and environment data between a Personal Computer

(PC) application and the device itse If. Although it is conceivable to perform all the major

instrument fimctions via a PC, this would mean serious constraints as to the specification

and utilization of the Pc. Typically a PC only version would require a dedicated unit and

careful attention to real-time software concerns and more importantly a device driver may

be required for each Operating System where this instrument would be employed. In a

similar vain, discrete logic circuitry could be used to achieve similar results, this however

would bring about unnecessary constraints andlor increased complexity. Therefore, it was

decided to design the main fimctionaI controls around a microcontroller system, as this

would achieve the design goals of a flexible instrument using a non-dedicated Pc.

5.2 System Overview

A 32-bit Windows application was written to directly intertace to a digital camera

and, more importantly, for this discussion it was used as a "master" to control the

instructions sent to the microcontroller "slave" unit. The theory and application of diverse

45
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communication protocols has been the subject of numerous research efforts. This

application, however calls for a relatively basic communication strategy as the data to be

communicated can effortlessly be packaged into jredetermined data types and sizes.

The decision to use to Siemens 80535 microcontroller was based on the fact that it

provided a flexible and versatile platform to accomplish this and other development

tasks. There is no doubt that, other microcontroUer systems could perform these

undertakings with similar results. [Semiconductor Group, 1991:14].
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Figure 5-1: System Block Diagram
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The 80535 is based on the widely used industry 8052 microcontroller. The key

features of the 80C535 microcontroller as pertaining to this design is listed in the table

below.

Table 5-1' Standard Microcontroller Features
Feature Details

On-chip Program Memory 8 Kbytes (Disable for this project)

On-chipRAM 256 bytes (SFR's are located here)

Parallel I/O ports Six 8-bit parallel ports

Serial ports 1 Full-duplex serial port (Not level compatible

with a standard PC's serial port)

Timers Three 16-bit timers

Analogue to digital converter One 8 bit AiD converter with multiplexed inputs

Digital to analogue converter None

Execution time l~ instruction cycle at 12 MHz operation

Special function registers (SFR's) are used to control and configure all on chip

peripheral components. The 80C535 microcontroller by its self provides most of the

functionality required. Additional circuitry was required to provide:

1. Standard RS232C communication

2 Digital to Analogue functionality

3. The ability to store the microcontroller software on an EPROM

i"n example of a development board using 80C535 was adapted from [Ohstrumn,

1997]. This adaptation extends the RS232 ability of the processor so that it was fully
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RS232C compliant It also provided a mechanism to execute a program stored on

EPROM. These are two key features required by the Kirlian Device. The circuit was

further developed as to include additional circuitry to provide Digital to Analogue

capability.

This development board incorporates just 6 integrated circuits (le's) and no other

active components. A brief description of the IC devices follows

. al Dde . FTable 5-2: Integrate lrcUlts unctIon escnptIon

IC-Part Description Function

80C535 Microcontroller Provides the control and functionality

74HC573 Address Latch Provide access to the 8 lower order address bits

74HCOO Address Decoder Divides the memory into four 16 Kbytes section

MAX232 Serial line driver Makes serial interface RS232 compatible

27C256 EPROM Provides 32K program memory

62256-10 RAM Provides 32K data memory

The development board requires various connections all of which is discussed.

The circuitry requires 5V DC which is provided by the analogue power supply see

Section 7.4. There is a reset switch which immediately restarts the program on the

EPROM. Access to the microcontrollers' ports is via I (}-way boxheaders. The

boxheaders provided for the interconnection to the rest of the instrument as follows:
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Table 5-3· Boxheader Description
Boxheader No. Description

K4 Serial lnterface

K5 Second Digital Port

K6 Analogue lnput Port

K7 First Digitallnput Port

K8 Frequency and Shutter outputs

Producing programming code for the microcontroller was accomplished by using

a commercial C programming language cross-compiler, namely Il.Vision (Rainbolt and

Associates). The IlVision implementation of C is based on the industry wide ANSI

standard with specific language extensions for 80C535 and similar microcontrollers.

The compiled code in lntel Hex format was written to an EPROM. This EPROM

was then inserted into the microcontroller system and became the only source of

programming code, as the on-chip program memory was disabled.

5.3 MicrocontrollerCode Description

The chief function of the microcontroller software was to interpret the serial

instructions transmitted by the software program on the Personal Computer. The software

flow diagram is illustrated in figure 2 below. The microcontroller scftware operates in

slave mode whereas PC program operates as the master. All the instruction to the

microcontroller was sent and received via the RS232 port from the attached PC. The
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main loop of the microcontroIIer software monitors the serial port then p::rforms the

required function and in some cases returns data back to the Pc. Besides the main loop,

two interrupts are also serviced

Global
Oedarations

Timer 0
Produces an interupt
every 200mS when
enabled

Get Next
Instruction

( In )

Count Time
Periods

Toggle Test
Signal

(END ')

Timer 2
Automatically
Produces 50% duty
cycle @ required
frequency when the
following are
correctly set CCR,
CC1, T2CM, T2PS,
CCEN

y Send
Check_OK

N

Received
y Receive Inst.

set_data Setting

N

y Send Data
Environment

N

Received
y Do Picture

take--Picture Function

N

Set Error
Conditions

Figure 5-2: Main Program Loop and the Two Interrupt Routines
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The main program loop follows typical C programming conventions. Global

variables were placed in the main function and were kept to a minimum. The setting the

Special Function Registers SFR of the microcontroller was key in setting the various

functional blocks. A SFR specifically referrers to RAM based memory location on the

microcontroller which accepts a byte as a control signal.

The system response time was non-critical as the values of the various device

settings are communicated the moment contact was established and is only effectively

used once the operator initiates the taking of a picture. Therefore a straightforward

configured communications interface was used, namely that of the setting of 8 bits, 9600

baud, no Parity and I stop bit. To achieve those settings, the following SFR's were set.

The SFR named SCON was set to 56H which placed the UART into 8 bit receive mode.

A standard baud rate was selected by placing COH in the ADCON SFR. The SMOD bit

was asserted in the PCON register which doubles the set baud rate frequency.

The interrupt system of the microcontroller was also configured by means of

SFR's. Initially all interrupts were disabled by clearing the IENO and IENl, while the

global interrupt enable switch EAL was set The 80c535 ports are easily configured via

software as input or output ports. All that was required to make an output port was to

write to the port in question; as such P4 and P5.

In addition to initialising SFR's and global variables the main function of the also

receives a byte from the serial port and a switch statement then selects the appropriate

alternate methods. The main loop would repeat it self loop until the microcontroller is

reset or until the power is interrupted.
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5.3.1 Exposure Time Signal Generation

The PC program allows the operator to specify the length of time the high voltage

is enabled; this is also the required exposure time for the camera. This signal was

generated by comparing the number of times Timer 0 was interrupted with the requested

time period.

When an exposure output event was required the exposure digital output port was

asserted high and while Timer 0 were enabled. Timer 0 generated an interrupt every

200ms when enabled. The code which serviced this interrupt rourine counts how many

times this interrupt was generated. This counted variable was compared to the count

requested. When the values were the same, timer 0 was disabled and the exposure port

was turned off. To achieve this functionality Timer 0 was placed in 8-bit auto reload

counter mode also called mode 2. This was achieved by setting TMOD special function

register to 22H. The reload registers THO and TLO were both set to 9C H. The exposure

time signal was made available through second digital output point on Port 4. A test

signal was available at line 8 of Port 4. This signal should be exactly 5 KHz and is

available so long as timer 0 is enabled.

As stated earlier, the exposure signal could also be used to provide a shutter

control for the camera. This method of activating the shutter of a camera could be

cumbersome, as a mechanical system is required to depress the shutter via relays and

solenoids. (Nonetheless co=ercial generic shutter re lease mechanisms are available). A

better method would be to use the software to control exposure time of the camera.

Software shurter control system was successfully implemented in the final prototype

instrument.
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5.3.2 Pulse Repetition Signal Generation

As with the other device parameters, the frequency of the device is adjustable by

the operator. Timer 2 in conjunction with software mechanisms facilitates the pulse

repetition signal or frequency generation. Two &oBit values are sent by PC software to

microcontroller representing the period of the pulse repetition rate by this formula.

P =(~h x256) + fie<I.-1

Where P is the pulse repetition rate in microseconds;

andfreq_h is the high byte received;

andfreq_l is low byte received;

(5.1)

Timer 2 consisted of a I6-Bit register (TH2 and THI) it would increment this

register every 1 microsecond (because a crystal 12MHz was used and the prescaler was

disabled). When the timer overflows it would be reloaded from the CRC register. If the

reloaded value was FFFEH the timer would overflow every microsecond. If the reloaded

value was FFFDH the time would be reloaded every 2 microseconds. Thus, the reloaded

value must be the exact number of microsecond away from FFFFH. Hence we use

CRC = FFFFH-P

Where CRC is the reloaded value ofTimer 2

(5.2)

A unique feature of Timer 2 is the provision of compare and capture register. In

order to implement a 50% dury cycle the CC 1 register was loaded with a value half way

between CRC and FFFFH it can thus be expressed by the tollowing formula.



. CCl= FFFFH -(PI2)

54

(5.3)

Where CCl was the compare and capture value ofTimer 2

The special function registers was used to place Timer 2 in a timer mode by

setting T2CON.0 also called T2IO to 1 while T2CON.l also called T211 was cleared, with

prescaler disabled by clearing T2CON.7 also called T2PS. Reload mode 0 was selected

by clearing T2CON.2 also called T2CM. With automatic reloading taking place when

Timer 2 overflowed. The compare function of register CC1 was enabled by setting the

CCEN register to AAH. This automatically configured tine 1of Port 1 to generate 50%

duty cycle square waves at the rate set by the PC software.

5.3.3 Communications Check

The purpose of this code was to establish whether communication between the PC

and the microcontroller was successful. This was achieved by PC software writing the

"comms_check" byte to the communications port. Ifall systems are operational, the

microcontroller would respond by sending the byte represented by "check_ok" back to

the Pc. A typically scenario for its use, would be when the PC program need; to be

certain that the microcontroller is ready for the next instruction, the microcontroller. Any

other value, no response, or delayed response would indicate an error condition. The

handling of error conditions is discussed in section 3.9.
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5.3.4 Data Dump Routine

This code was used to transfer the values received by the analogue collection

routine to the Pc. The relevant data was stored in the appropriate global variables and

then written to the serial port with a certain heading and trailing value. The PC program

initiates this transfer by sending «data_dump" byte to the microcontroller and then

expected received data to be in the correct format or else an error was flagged.

Tabl 5-4 D Dum P k Ce ata ap ac et oDStructlOn
Header Temperature Pressure Light Humidity Footer

31H OtoFFH oto FFH oto FFH oto FFH 39H

5.3.5 Set Values Routine

This code was used to obtain device setting from the Pc. The packet received

should be in the format shown in Table 3. An error condition was raised if the received

packet was not in the prescribed format

Table 5-5· Set Values Packet Construction

Header Voltage Frequency-Low Frequency-High Shutter Footer

67H Oto FFH oto FFH oto FFH oto FFH 57H

5.3.6 Take Picture Routine

This crucial piece of code initiated the taking of a Kirlian picture. This sequence

of events would be initiated when the PC sends a requested in the form of the byte

represented by «take-picture". In the preceding communicating sequences the Set Values

and Data Dump routines would have been executed. It therefore can be reasonably
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assumed that PC software has ail the required environment measurements and that the

appropriate instrument settings are in effect. Consequently when the request for a

photograph is made by the PC, all the microcontroller has to do is enable the Timer 0

interrupt and disable it again when the required number of interrupts has occurred. This

occurs in the first interrupt routine itself.

53.7 Analogue Data Collection Method

The method to collect analogue data accepts an argument for the analogue port to

be measured. It then returns the average of six NO Analogue to Digital conversions for

this particular port. Each port is internally multiplexed. Measurements are achieved by

setting and reading the appropriate SFR's namely ADM, ADCON, DAPR, and ADDAT.

5.4 Error Handling Mechanisms

If an error condition was detected, it is responsibility of "master" device, in this

case, the PC to display the error conditions to the user and halt all other device

communication processes. The appropriate user response, in most scenarios, would be too

reset the microcontroller. This reset simply places the communicating devices in a knovm

state.

5.5 Additional Hardware Provisions

The high voltage system requires one Digital to Analogue channel; neither the

microcontroller nor the development board has a Digital to Analogue capability. This
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shortcoming was addressed by using 4 Digital Output with appropriate the external

analogue circuitry to produce a D to A channel that had 16 discrete levels. See Chapter 4

for details.

5.6 Conclusion

The use of a microcontroller provided an elegant solution to controlling the main

instrument functions of the Kirlian photographic device. The ability to easily add more

data channels is a great boon to this instrument design. With integration of the processing

power of a modem PC with the technology, advantages of a microcontroller and digital

camera a powerful instrument can be constructed. The duplication of other significant

research efforts could be accomplished relatively easily.



CHAPTER 6

DESIGN OF THE COMPUTER PROGRAM

6.1 Introduction

No matter what the capabilities of any instrumentation, its use and ultimate

acceptance may depend on the operator to effectively interface with its controls. Reliable

Kirlian experimentation can be tedious on the operator as there are many aspects of the

environment and of the instrument to consider [pehek et al, 1976]. Most critics of the

Kirlian research agree that reliability and stability are key performance areas when

investigating this phenomenon. The software designed and developed in this dissertation

addresses these key issues by having an experiment centric view of the way pictures are

taken. Restated, performing of scientific experiments are facilitated by the software

program produced.

6.2 Programming Requirements

A non-trivial application program called "The Kirlian Experimenter" was

developed to act as interface between the user and the instrument. The program is written

for the 32-bit Microsoft Windows operating systems more specifically Windows NT,

Windows 2000 or Windows XP, although it should work on the other Microsoft

operating system products as well. The programming language used was C~:" and the

development environment was Borland C++ Builder version 5. The code consists of

about 3400 lines spanning 6 forms. The body of the main form is listed in AppendLx B.

58
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Figure 6-1: Main Windows for "The Kirlian Experimenter" Program

The primary task of the program is to filcilitate the conduction ofscientific

experimentation into the phenomena of KirIian photogrnphy. The software is purposely

designed to act as interface between the operator/experimenter and the electronic and

photographic hardware. Without this software, it will be almost impossible to test the

capabilities of this hardware. The critical functions of the program are listed below:

I. To provide a means to set the voltage and frequency parameters of the

High-voltage supply.

2 To collect analogue values of from the environmental subsystem.

3. To control the sequencing of events to take a Kirlian picture.
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6.3 Overview of the Program Flow

The program was designed with standard Windows feattres to reduce the amount

ofleaming required. The program starts with a splash picture showing a typical Kirlian

picture. Thereafter an initial screen displays all the data of the first default experimental

picture. Although the program interface appears daunting at first, as the main experiment

features are navigable from this initial page, the interface is intuitive enough to allow

rapid familiarization of the instrument and its software.

The typical steps required when taking a Kirlian picture, involve setting up the

physical object of the experiment, and then using the software to take the picture. Consult

section 8.2 for a detailed explanation as to the correct way to setup the subject. The

software via the status bar will alert the operator whether communication with the Kirlian

device is successful or not. If communication has been established the operator should

select an appropriate Kirlian Experiment Template (KET) to use and modify device

settings if required. The operator has then the option of either modifying the KET

comment and/or comment about the picture about to be taken. The operator then selects

the environment tab sheet. This tab sheet is mainly for information purposes and it is

from this point that the "Take Picture" button is active. The operator has only to press

"Take Picture" for the Kirlian picture of the subject to be taken. The software program

then performs all necessary communication with the device hardware so that a picture is

taken and downloaded to the Pc. This picture will appear bounded in the "Last Picture"

tab sheet. Gu'1 buttons will be activated which allows actual or full-size picture to be

viewed as required by the operator.
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6.4 OffIiDe Viewing

OffIine viewing allows the operator or anyone else that has a PC to view the

Kirlian pictures and its associated data. See Figure 6-2 for an example of offiine viewing

form. This functionality is accessed by selecting "View Previous Experiments~ in the

"Options~menu. There are three lab sheets in this foDD, one for a Data View, another

for a Pictnre Viewand Iasdy a Select Directory lab sheet All the pictures and data

taken with a particular KET will be stored in its own directory and will automatically be

listed the. This Select Directory lab sheet could have easily been called Select KET

instead.

Figure 6-2: Example ofOffiine Viewing
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6.5 Additional Operator Controls

Other options available to the operator include but are not limited to:

I. Changing the communication port (COMI thru COM4)

2 Enable the High Voltage supply without a camera communication, Useful

for debugging

3. Access Online Help

4. Access the About Box

5. Real Time camera view although Not Implemented Yet (NIY) at the time

of this publication

6. Load the default KET

7. Save a new KET

There is no option to adjust the date and time via the progranune itself following

standard software application programming standards. It is therefore imperative that the

date and time be adjusted correctly on the PC, as the program automatically obtains this

information from the operating system.

6.6 Program Design

In order to achieve the required functionality and to cater for future enhancements

a formal program design was attempted. Formal program design for typical GUl

(Graphical User Interface) type programs are primary based on Object Orientated
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principals and more specifically the Universal Modelling Language (UML) standard. The

program under discussion requires real-time execution. This has a serious implication as

true UML modelling would reqnire further investigation. Therefore a sequentially based

design approach was used. When analysing GUI programs in a sequential fashion it is

prudent to use multiple flow diagrams to represent the various "threads" of execution.

The flow charts used for this design are documented in Figure 6-4 through Figure 6-12

From an Object Orientated view, the base class for this program is the Kirlian

Experiment itselfwith its associated data and methods. Thus, a class KDataClass1was

created to perform this requirement.

S d· KD Cl IdData TTabl 6 1 De - ataan - l ypes tore ill ata ass
Data Encapsulated in the KDataClassl Type of Data

Date and Time of the experiment AnsiString
Comments about the Experiment AnsiString
Comments about the Picture AnsiString
Base File Name for the data and picture int
Applied Voltage int
Frequency of the supply int
Type of Ground int
Exposure Time int
Type of Lens AnsiString
Focal Distance int
F-Stop or Aperture Setting int
Measured Ambient Temperature and the int
lower and upper thresh holds
Measured Atmospheric Pressure and the mt
lower and upper thresh holds
Measured Ambient Light Level and the lower int
and upper thresh holds
Measured Humidity and the lower and upper int
thresh holds
Measured Object Pressure and the lower and int
upper thresh holds
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Following standard Object Orientated design approach, each datum has its own

accessor and mutator methods. The code required for this functionality is listed in

AppendixB.

Standard programming practises was applied throughout this application.

Although using a Gill development package such as Borland Builder meant that standard

Windows programming issues were taken care of, there were a numerous of thorny

programming problems to overcome. The first oftrese problems was setting-up reliable

communication via the serial port. Secondly, the real-time nature of the program meant

that synchronizing the communication of events required a communication strategy

implementing packet data transfer see Chapter 5 for a more complete discussion on this

topic. Lastly, communicating with the digital camera via the USB proved extremely

taxing programming issue, at first a partial solution was found through spawning an

external program, which interfaced with the camera [Menchenin, 20031. Ultimately, an

elegant solution was achieved by using the Olympus SDK [Olympus 2003].

6.7 Program Versioll'l

Anecdotal observation suggests that most complex software projects are never

truly complete as there are always enhancements and bug fixes. This project is no

exception. The current version of the "The Kirlian Experimenter" is 1.27. This

information and direct access to latest software release is available via the About Box.

There are no known serious bugs to report on this version.
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About ~~~

~;:a:a:~ca'l take KiWI photographs I ....eded la a \
deoicaIe KiWI D.w:e.

Mae~ tm progr.n aids the coIedioo I 0/
scionliic KiWI photograptic data by enaIirog e><peo'"e.iabon

ClIpJript:

EMall Adress:

Internet:

sYaweU Wtlllilms 2001

Yliliamss@pentech.ac.za

YWli.pelltech.ac:zatsydweU

Figure 6-3: The Program About box

6.8 Flowcharts ofthe Main Form

This section lists the flow diagrams of the main form These diagraIlls follow

conventional fiowcharting techniques. Most of the code of the MailJ. Fonn is in methods.

These methods are number in the flow chart and the code itself. See ~Ildix B. Main

this form is called K2001Maio_f.
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The following symbols are used expanded the traditional flow charts information.

o This symbol is used to indicate the start of a Gill event/thread

There is no symbol to indicate the end of a Gill event/thread. This

was done to keep the picture sizes with in limits. At the end of a

thread or an event the program simply waits for the next GUI event or

Poll routine timeout.

This symbol is used to indicate a parallel process

6.8.1 Initial Flow Diagram

Methods J.l to 1.3 create, activate and initialize the main form. See Figure 6-4 the

flow chart. Many initial Gill values are set in the original form designer of the IDE,

although some setting which material affect the initial state of the displayed program are

placed in the method lA HouseKeeping. The default experiment template is also loaded

from the file "default.ket". The page control method 1.5 Main_pagectlChange

determines whether the last picture or the current environmental values are displayed.

Currently the third page tab is not operational this should display the current camera

View.

6.8.2 Picture Taking Sequencing Details

Method 1.7 (TakePicture_burClick) handles the code required to take a picture.

See Figure 6-5. The actual code to be executed depends on which page is displayed. If the
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page control displays the last picture then pressing the Take Picture button will display

true size version of the last picture taken. On the other hand if the environment variables

page is displayed then further preparation for taking a picture continues. The camera

conununication is checked and if it is ok, the camera settings are activated. A global

variable (PicrureRequested) is set so that when the poll routine knows a picture was

requested see section 6.8.3. The method then waits until the picture is taken and then the

download of the picture is commenced. The picture is then displayed in the main page

control window.

Method 1.8 (getKDataFilename) is called to automatically rename the next

picture to be taken. This code then takes the KET and the next file name in sequence from

001 to 999. Method 1.9 (DisplayKInfo) is also called redisplay this data.
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Figure 6-4: Initial Flow Diagram
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Figure 6-5: Picture Taking Sequencing
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PolIRoutine timer

• 1.10 l1merroutine accessed every 1000 ms (1 second)

· --'" GUI designer TImer routine

( Start of time< \: · Effects, This is the timer interrupt handier

'- J. - · a) Cammwlicates with the micro and displays appropriate
~ diagnostic infarn1ation

· b) Displays the environment variable ill the appropriate colours,
· Blue if the variables are within range of in the KET

· Green if the variables are beloW range of in the KEf

· Red if the variat»es are above range of in the KET
· c) This routine is disabled when the main form is not active
·· Return: ,,'"

J

CommsOK? Clear Comport I----- Receive Data from
r--"

Display the data in
r--"

Send."", -
""""""'" "","",format -

o;,playEmr
Send Talte Picture """'" send Device ---'" T

settings

Endofrmer'-Figure (>,6: Poll Rounne Flow Diagram

6.8.3 Poll Routine Details

The Polling Routine 1.10 checks RS232 comport and depending on whether there

is an error or not, the environment variables are displayed or an error condition. See

Figure (>,6. This routine is responsible for displaying the alarm condition as well as

sending tlE take picture byte to the microcontroller if the global variable

(PictureRequested) is set.
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NEWSECTIOM
2

Kiriian~TerfIPl<ile(KET}V<*Jes

r
r
r
r
r 1) This sediPn 0JlItains ail the KET values
I" 2'1 These are all GUl dil!Ii!J'ef~
r 3) lnilial seditIg ale conligu<e by !ha GUI designet",

~ GUI designer Templale mermCllanyed
ElJeds: Sets II'e Experiment TempIale ConmenI:
Rellm: 'oIllid

A_
"""""

All routines in this
section can be
represented by this
_chart

"'" """"r-=----.---------~ ..---.-.---.
• 2.7 ElIeculad when user changes !he Foo::aIIttngIh via l/1e Fo<:3 up dDwn dick

------, -----·---·--·---u
~ VoIlage UpIOowtl Builon Pres:;;ed
Effeds:; Sets tile Voltage

""""" ...
Arguments; GUl designer Focal up dc7M1 dded
E/fec:I:$: Sels the Focal length
RelIJrn: void

--_.,

Frequency_udCticlr;

• 2-3 E:1Iaa!lBQwnenuser~~Ys tl'III>~ up<Jo.wididl.

Thenl are UIlique iJ'iPe'iE!l,talillrl is$ues~ the Frequency di:sp;iy
a) The courUlg~ relieS on !ha up """'" only
tll~iselrededby ~lhela5ldigll:aAy
cl The Freq!.Ierq variable is 10 lime!!l.1te acIll2IlreQuuncy
dl A Io!blII is usud to indicate wtlett1er lhe fI8QlJ8flCY is Hz Of kHZ

$etlsiliYily-tmCtlange-_._-----------------------
• 1J!, ~wilen\I5I3Fd\IlIlge$ft~via'lte~aJfl'Ibobl:L\

•~ GUI ~SensilMtycombo!lax Pressed
• 8IBd$: S8ts IiIe SensitNily
• Rslum: void

&pe.menCmemoChange
r--- ...-------------
• z..g E>:eculed 'Iltlen U$llI"~ the Expenrneot commeot

• Arguments: GUl designer~ 1TIemQChangad
• Effects" S8ls the Expenmenl CommeI'll
• ReI1lm: ;ooid------------_·_-------------··'1
MillTefIIP_edChange
r--- ....-----
• 2. to E:uIculed wtitIn user d1anges the P.immum Tem~

~ GUI des9- Minimum Tempo!faWI'e. dIaoged via~ or the
• lip/down c:Iidt
• E!fecb, Sets the Minimum Temperature

--------------/ • Return- VOId

HgLmenIs: GUI designer Ground a:xnbo ba>; Presse<i
E!fel:l:S: Sets l/1e Ground

""""" ...
l:ra~~------------- ......_---..- ~nAlmPress-edChange •__...__• ••••__•••• ..__•

• Arguments: GUt designer Exposufe =nbG tlcl( PresseIi
• Effactt Sets me Exposure
• Reun: 'IIXI

-----.--. ····_-·--··1

Arguments" GUI de!oigner Mirumum AlmOSIJilenc PressuIl3. cnanged Ilia :extDo.<

• ortneupl~ did<
• ~ Seis the Mirnrrl\lm A1mospne<i<: l're5sure
• Rewm: 'IOICl._--_.__...__..._..._-~._ ....•-....._-_....--..,

,
• 2-6 8\eCt4Sa Wflefl ""'" d!aoge5 the Lens via the U!f1S eaii box

Minlight_ecCr.wge.----------
• AlgumeIlts: GUlllesigm,rlf;r!5eaiiboxProsseri
• E.'feds: Sets me Lens
• Raum: '.0::1

·-·--~··_...._----·-----·······~~-·--·~r

Arguments: GUI <iesignt!r Minimum LJgIl! LeveIo.i, cnangea vl3 texIbox or me
• Ltp/liown c±id<
• Elfeas: 5e!:5 tna Minimum ambient Wgm levBls
• Return· vOId.

Figure 6-7: Kirlian Experiment Template (KET) Implementation
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6.8.4 Kirlian Experiment Template (KET) Implementation

These routines are relatively straightforward all KET values whether they are text

or integer are simply edit as the experimenter request it All these items are listed in

Table 6-1. Also see Figure 6-7 and Figure 6-8 for the relevant flow charts.

6.8.5 User Dialogue Boxes Details

Standard Windows user-interfacing techniques were employed, two examples are

the KET can be loaded or saved under the file menu item and right clicking the status bar

allows access to the communications port setting. The Figure 6-9 shows relevant method

names and numbers used.

6.8.6 Serial Port Details

These routines allow the user to set the primary communication, which interfaces

to the RS232 port. This allows any of the standard serial ports to be used namely COMI

thru COM4. Method 3.10 (SetCommPort) first initializes the port settings such as the

Actual Comm. port to be used, Baud rate, Parity and Stop bits if any. Appropriate errors

are flagged giving a visual indication to the user.

Method 3.9 (GetCommPort) simply returns the active Comm. setting while the

Serial Port menu option, Method 3.6 (SeriaIPort2Click) displays a radio button form,

which allows the user to select a new port.
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r NEWSECnON
r 2 Continued
r--

MinHumid -edChange
r----- .~:....---~---------
• 2.13 Executed when u5er changes the Minimum Humidity

Arguments: 001 designer' Minimum Humidity, changed via texIbox or the
Ul)/dt:Nm diclr..
EffeCtS: Sets the Minimum Humidity

Retu<rr """

,
• 214 Executed when user changes the MInimum Object Pressun!-

Arguments: GUI designe{ Minimum Otljed Pre:ssure, changed via tex!box or
• the upldown dk:k
• EffedS: Sets the Minimum Object Pressure

• RelUm: void

~BdC.~_:;::... _
• 2.15 Elc:ea.Jted wI1en user- dWlgBS the Maximum Temper.;rture

Argun'Iaf1ts: GUr designer Maximum TempemtI.Jre, changed via texIbox or the
up/down click
Effects: Sets the Maximum Temperoture
ReIUfrr. void

--­,.....-
• 2.16 Exewted when user challges the Maximum Atmo5pheric: Pressuce

Ai"gUments: 001 desigief Maximum Atmospheric Pre5slre, changed via textboll
or !tie upldown ~
EffedS: Sets the MaximUm Atmospheric Pressure

_Retu<rr:::::;;;~..::""":.;... • .,

-­r
• 2. 17 ExeaJteci wnen user~ the Maximum Ugirt levels

Arguments: GUI designer Maximum Light Levels, d1arJged via textbox <Y the

• upIdown dick
• Etrects: Sets the Maximum Light levels

:~ """._-----

• 2. 18 Executed when user changes the Maximum Humidity

Arguments: 001~ MaW1urn r+umidity. d1<1nged via textbox Of the
• upldown dick
• EIfect:s: Sets the Maxi.'lJ1Jrn Humidity

• Return: void

MaxObjPress edC11ang:~e:....__ ~_",,,,,,,. • •••~...

• 2.19 Executed when useI'" dlanges ttle Maximum Object Pressure

Ai1JUrT1efllS: 001 designer Maximum Object Pressure, ci'langeC via textbox Of !tie-
uplda...m ciiclt
S'lscts: Set:> !he Maximum O'ciea Pressure

Retu<rr """ _._-----_.__._.~~-!

Figure 6-8: KET Implementation Continued
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._---,

Arguments: GUI designer rl'\SfIU; Hel9 -:> About Clued
Effects: Opens the About form
Return: o,tid

~ls: GUI designer menu New Klrlian Experiment Tempiaie (KET) Clicked
Effects: Set:s aY the- KEf values their default values
Retum: 'JOid------,--

--_ _--_.._--_ - .._-~ _ _-,

, .,.
/........... '

~--------,

~ ' ..-
\ ~~~,~.

\---;_/

i
;
;
;

:-;---1---;-;
; ! Calls AOOut i ,
i i Menu Option; i
i i (3.13) i i
'-......_---~..!

.. 3.1 Loads the default expeMlenI: template

s~QtIjecI:"SerIdef, TPoint &MousePos, bed &Handled)
~------ ........._--............__..
.. 3.8 Right dicking the Statusbar also brings up the Serial port--

.. 3.3 saves the exisling KEf values irrto a user- spec:ified ...ket file

;
;
;
;
;
;
t

­;
T

,
CaIis Set. i

COMS Port i
(3.10) I

c..l. .LJ

,-----" ....../ .......,.

\" S2" j/ ~'.,"'a>le(TO_._
.. 3.14 Opens the AI:Jwt form

,
;
;
T

Got_
~

NameO·S)

Write K1nfo data

i,
;
i!
~-,.,_.i.C

;
i

._,__.L..-.,.-:
! j j !
! ; Display Kinfo i !
1! (1.9) ! l
i ! ! i
~__-J......!

LoadExperimentTernpiatelClidl.
r--
: 32 l..Dad a~ saved Ki1ian experiment tempIaie (KED

ArgtmenIs.: GUI designer menu RIe -> Load KiJIian Experiment Temp1ate crICked
Effects: Opens a daIogue box 10 load a KET
Return: void

.. Arguments: GUI designer meBJ File.> Save Kirtia1~ Template (KET) Clidted
/ ..- I3reds: Opens a dialogue box to save a KEf

.........,.,.,....... ,...:."""";;;:.;:..-;""";:':..._---

j • • ......

\. &Ne ' ..
\ E,xperment ,;;. .

\. Tem(:lIale ..
; ;,

;
;

! ! ~Fie ! 1
! ! DiaIog Box ! !

1 !(T<Jpen[Jiab;j) 1 !,
;
;
T

\ ~ If-~-T""""".
1

Open Re

D;alog """
IT"""""",,,,)

1
Read Klnli:l data

1
Got_
~
Name(1.8)

1
D<pIay I<info

(1.9)

Figure 6-9: User Dialog Flow Charts
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SelCommPort,..-----------'---

.. 3.7 Opens a newfomJ showing the serial port selected

.. A ciffetent serial port can be selected

~ts: GUI~ menu: 0p\i00S -> Serial Port C\idled
Effects: Opens SertaI Port fonn
Return: void

SerialPort2C1ick

Argwnents: Attempt to set the port to this value
Etrects: A mutatorrnethod which attempts to set the CarnmUnications Port used
Return: true if successful

JniatiIize Varib!es &
Show Port to test

.. 3.10 set: the Cl..U'TeI1t Communications port, as specified by the user.

r ----, .------:,.-- ..

\ ./

Is Handle
Valid'?

>----NO'--->l"""ay Emr& Se!
Status Bar to RED

\ SericlI Port /
\ j
, Menu "i
\ Option
L-r--l

Is Comport >- NO__->jDisplay Error & set
Status OK? Status Bar to RED

YES

YES

!sC",""""
Test Ok?

)--__No__->jD;splayEm><&Sel
Status Bar to RED

YES

1
Display Valid Port

& Set Status Barto
YElLOW

;
;

fr-.-L-n
! ! SetCOMMS! I
i j Port (3.10) i i

i 1 .lJ

........~..._--./

Sertai POIt Form (SertaLcpp)

Arguments: void
Effects: An accessor method whid1 returns the Communications Port used
Return: The communicatiOnS port used

: 3.9 Gel: ltte current COJnrTlunieation port setting

Return Existingeam__

" -----;
\ ;
; Get .

\ Con1port /!'f:;.,............ ....
----:--' •...•..._.GetCommPort

! I" .~••---....~....~~~------_._-- .......--.......
;
;

t

Figure 6-10: Serial Port Flow Diagram
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·3.4 Exit the I=I"O!J3'TI gacefulIy

___ Arguments; GUI desqIer Exit Buttorl CIidIed

_ ..-__..-".- • EJfeds: Exit the program immediately if !he variabllils lhat makes up the !<ET did
r ~ nol: change else asked user what b:I do

• Return: void

N Yck-----'+

---------_._._-,

8Ol1::::;-=Clid<~ _
r'
• 3.5 Menu handler for Exit Opticn

~ GUI desigrler I'TlefU: ~de -> Exit CIieked
Effeds: calls ExiCbulClic:k
Return: void

F_r-._--.-------
• 3.6 ~fa' Main Form X djd(ed

• ArgtmenIs: GUI designer Form X dic;lled

• Effeds: calls ExiCbutClick
• R~: ~OO-------

,
Exit: Menu k------
"- ;

-~,--'!
;
;
;
;

jl t i J

i i Calls Exit ! !
i f 8uttD"1 !!

11 oaea{3.4) !j

\,
\

\

. ;

\ Form Closed .,.i~\Clidted
,
;
;
;
;

i' t
i i Calls Exit
i! Button ! 1
I !crICked (3.4) f 1
L.i i i

6.8.7 Exit Routines Details

If the user modifies a loaded KET the user has an opporrunity to cancel the exit

command and then save the KET. The exii strategy employed is shown in Figure 6- It.
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View

Exoeri."moot
Menu Option

Show Data & Picture
ViewFoon

(DataPictlJreVlElW.cpp)

Show About: Form
(Aboutcpp)
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~::_:::;:=':::::::;CIi::::d<:.... _
.. 3.11 Opens a new form showing previous experiments

Alguments: GUI designer met1u: Options -> View Experiment Clicked
Effecls: Opens the Data and Picture Viewer form
Return: veld...:.:=:;....;;::...._._------------,

AbOUt1Clid!:
I
.. 3.13 Opens the About form

Algumenls:: 001 designer menu: Help -> About Clicked
Effects: Opens the About form

Relum ""'"

IJVhatisk1rlianPhCJtography1 Click

. ,
, i\. ~:=n ~L\~_---­

\ 0pticI1 i
'---r--",,

j
t

Show 'Nhat Is Form
(Whatls.cpp)

I .............**...................-......••

.. 3.15 Opens a new form showing thepeos a new form shawing Help Detaits

Arguments: GUI designer menu; Help -> What Is Kiriian PhotOgrapI1y Clicked
8feds: Opens the Whatls form
Retum void

"-,-------7
.. Enable HV with ;~

\ out camera r., !
i !----r--

;,,,
•__--ltL-__•,
! Togglestheabiltyto j
] manuaily take ptetures i. ,

--
Enab/eHVwittJootCamernCnd
, ._---_............_-----~_ ....*............

.. 3..12 Toggle the availability of lhe higl'l vcKt3ge system

Arguments: GUI designer menu: Options -> Enable HV without Camera Clicked
Effects: Toggle [he availability of the high voltage system even though the camera

might not be available
Return: void
.~;:;;....,.;;;:.------_.._.._.-,

Figure 6-12: Menu Options Flow Diagrams



79

6.8.8 Menu Options Details

Other miscellaneous methods include the View Experiment option, method 3.11

(ViewExperimentClick) which opens a new form allowing the user to view previous

experiments see the section 6.4 on Omine Viewing. The about box is activated through

method 3.13 (AboutlClick) which opens a new form. Online help should be activated

through the method 3.15 (WhatisKirlianPhotographylClick) this method is not

implemented in this current release of the software version 1.27.

Method 3.12 (EnableHVwithoutCameraClick) is used during debugging as the

name suggests it will enable the High Voltage output even if there is no digital camera

connected.. This is useful when testing other camera systems. These flow charts are listed

in Figure 6-12

6.9 Conclusion

The software engaged with this device, has been developed from a reasonably

elaborate coding task. The final success of this project will depend on whether this code

and its experimenter centric view of the instrumentation can be relied upon to produce

repeated successful Kir lian photographs.



CHAPTER 7

INTEGRATING THE COMPONENTS

7.1 Introdnction

The different engineering systems were integrated in a cohesive uuil In order to

be an effective instrumeut a number of design issues were addressed. The completed

instrument is shown below in Figure 7-1. General component interconnection is

discussed in section 7.2 The mechanical construction is detailed in section 7.3. The

power supplies and their construction are revealed in section 7.4.

Figure 7-1: Completed Kirlian Instrument Housing

80
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7.2 Component Interconnection

A brief technical description of the system as a whole is outlined in this section. A block

diagram of the instrument shows the various sub-sections that need integration (see

Fignre 7-2). Starting at the bottom of the diagram and working our way up in the bottom

left we have the environmental sensors. The sensor signals are conditioned by supporting

circuitty to provide outputs in the range 0 to 5 Volts (section 2.3). These signals are then

feed in to the Digital to Analogue port of the microprocessor (section 5.1).

v -DIGITAL
CA.~RA

'"
TiqVd

EloJvv.le
~ I

m
,
, HighVoImge

Ul SuwlY
]

Shutter Frequency
Timing Signal

Generation

PC RS232
Digital I DtoA I

Front End Il-Processor Output

(M.A.STER) (SLAVE) Ports

AtoD

Enviromental Am.
Sip!

Sensots
C"'Cili",;,

Fignre 7-2: System Block Diagram
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The micm:ontroller generates a square waves in response to the operator

requested frequency value. This requested value and others comes from the PC program

via the RS232 port. The square waves are ultimately used to generate the production of

the high voltage source. This high voltage source requires galvanic isolation which

provided by the optc-isolators (see section 4.6). The duty cycle of this square wave is

adjustable and this in turn modifies the amplitude of the high voltage output.

This duty cycle input originates from the microprocessors digital output port

which switches in the appropriate resistor according to required duty cycle and thus

ultimately the high voltage output. In addition to communicating with the microcontroIIer

the PC is required to canmunicate directly to the digital camera. This is achieved via a

USB port and cable (see section 6.8.2). When using the Olympus Camedia C-4040 Zoom

camera (see section 3.5.2). The software program developed provides full control of most

camera settings.

7.3 Mechanical Construction

An important design feature of this Kirlian Device is that it is self-contained. All

the optical mechanical and electrical systems are housed light tight box constructed out of

wood. This has great benefits for the investigator, as there is no need to work in a

darkroom. It has the additional feature of a light tight sleeve so that Kirlian pictures of

human hands and/or fingers can easily been taken. The box was made out a standard

laminated wood shelving available in hardware stores. Wood was chosen as the primary

construction medium as it is relatively inexpensive and easy to work with. Most of the

electronic circuitry was constructed on a popular prototyping strip board.
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Inten:onnections of the boards were made with book-up wire and standanl keyed plugs

and soc:kets. Figure 7-3 shows an internal view of the device with most of the electronic

circuitry exposed.

Figure 7-3: Interoal Picture of the Kirlian Device

The design features include a separate area for electronics, inren:bangeable

camera mountings and easy accessible compartments of the TLE and camera. All

accessible compartments are closed by means of canopy clips. Tbe entire box is painted

matt black to aid the expulsion external light soun:es.
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Different cameras can be used in the box these include standaId SLR cameras,

digilal cameras or even a video camera, although the latest "Kirlian Experimenter

software" only supports the Camedia range of cameras by Olympus.

The Front panel ofthe Device conlains a minimal nwnber ofswitches and

connectors. These are sbown in the Figure 7.4.

Light Tight Sleeve

LED indicating High

Voltage activation

Re.et Switch

USB CoDDector for Digital

Camera

Seri.aI Cable Connector

Mains Power Supply

Connector

Figure 7-4: Front Panel Connections
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7.4 Po_r Supplies

Standard linear power supply techniques were used to provide DC power to the

various circuits. The table below details the voltages and currents provided for:

Table 7-1· Power Supplies used by tre Device
Circuit Voltage Curreut Comments

Analogue Data Acquisition +5V 700mA Supplies the llProcessor

+12V 500mA as well

-I2V 500mA

Microcontroller Board +5V 300mA

High Voltage circuitry +I4V 500mA Microprocessor

+20V 3A regulated Supply

(Section 4.5)

Digital camera 4x 12V 1800mAh Nickel Metal Hydride

Batteries (NiMH)

Note although it would be a trivial task of providing DC power to the digital

camera, it was decided not to do so for two main reasons. Firstly, the power supply

requiremerts vary greatly between different digital cameras manufactures. Secondly, the

warrantee of new digital camera does not permit the use of thinl-party power supplies.

7.5 Data Acquisition Power Supply

Basic supply generation techniques were used in designing data acquisition power

supply. A dual complementary full-wave bridge topology was employed (See Figure 7.4).

The ~\1S current rating of the transformer using this topology is 1.8 x DC current
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requirements. The VA rating required by the mains transformer is equal to the swn of the

three output power requirements.

d

+5V

Ul t .,2V U3 1
L.M117 LM7805

t--'- • ,rr ,
~ III oO\rT.....L...!

3 •< •
R3 R6

1
• lk .

r 8R1 .
R2 240 C3

~~ "lID ~

. " . , 21<7 100ur

r, ! ~ C\l

+-0 '!= Cl
~ Analog GrounA . tOOOuf R1 ,

1K5 R4 DJ,z
~ C2

LED
1000ut U2 120

.1 3 R5
< ,• ,rr

lk"1.M337

T

011
nOVae 30V

'7 -12V

Figure 7-5: Data Acquisition and Microprocessor Power Supply

VAT = [(+15V)Power +(-I5V)Power + (5V)Power]XI.8 (7. I)

where: VAT is the tOlal power ratting for the transformer

VAT = [6VA+6V.4+3.5VA}x1.8 (7.2)

VAT =27.9V.4 (7.3)

A centre-tapped 30VA transfonner (TI) with secondary winding of 17 volts, 0

volts, and 17 volts was used. A bridge rectifier (BRI) rated at lA supplied the three

IOOOfiF filter capacitors (Cl & C2 & C3). Empirical formula (7.4) relating peak-tc>-peak
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ripple voltages Vp-p to capacitor C size and load current IL is given by the following

formula [polen, 1981}.

I L •
C =--x7.2xI0-'

Vp-- p

(7.4)

With this arrangement the maximum ripple voltag: for the positive regulators at

maximum load IL = 1.2A is 1.8Y. The minimum transformer secondary voltage is given

by this formula.

(V +V +V +V. ) IV :::::; Dui reg ret:t rtpple x-::;;15.4V
~ 0.92 -fi. (7.5)

where: 0.92 = rectifier efficiency (typical)

Vac = Transformer secondary Output

Vout = Required output voltage = 15V

Vreg = required voltage differential ofthe regulator = 3V

Vrect = Voltage differential across the diode = 2 x 0.6V = 1.2V

Vripple = Ripple voltage = 1.8V

Note this equation does not cater for low line AC conditions. A transformer with a

secondary voltage of 17AC was used. The positive & negative 15V regulators are

variable output voltage regulators. The outputs are governed by the following equations.

For positive voltages:

(7.6)

where: R2 must be 2400

R3 is selected to be 2K7
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Resulting output = Vout = 15.3V

- VUU' = 1.211+ ~:)

where: R4 must be 1200

R1 is selected to be 1K3

Resulting output = Vout = -14.8V

(7.7)

A fixed 5-volt le regulator was used to generate the 5 volts required by the

microprocessor. LED's (D6 & D7) was used as indicators on the power supply board.

Standard electronic and mechanical solutions were employed to integrate the

various systems to a convenient instrument.



CHAPTER 8

PERFORMANCE

8.1 Introduction

As with any real world application of technology the proof that an instrument or

system is effective is largely detennined by it is operational efficiency. This chapter will

demonstrate the effectiveness of this instrument as a potential research tool. Important

aspects of the performance of this device are detailed in this chapter. Basic operation is

detailed section 8.2. Image quality is discussed in section 8.3. A real world experiment is

perfonned in section 8.4. Safety and other aspects relating to human subjects are

discussed in section 8.5.

8.2 Experiment Walkthrough

A typical experiment would start by selecting an appropriate subject and possibly

the experiment variables to modifY. For this example, we selected a coin.

I. Place the coin the TLE and visually align it with the camera lens.

2 Connect the grounding electrode to the coin.

3. Close the lid of the Kirlian experimenter box.

4. Start the application if it has not already been started.

89
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5. The experimenter then has the option of loading a previous KET or

creating a new one.

a. To load a new Kirlian Experiment Template (KEn click on file and then

load and select the KET required.

b. To create a KET by modifying the all the experiment conditions as per

experiment design and then save these settings as a new KET.

6. Make sure the environment page is displayed by clicking on the

environment tab.

7. Comment on the picture that is about to be taking a the text box provided

8. If all the setting are satisfactory simply press the Take Picture button

After a few seconds, depending on the exposure time selected, the Kirlian

photograph will be displayed. This photograph together with its measured and selected

data will automatically be saved in a folder bearing the name of the KET. Automatic

naming is employed so that the operator does not accidentally overwrite an existing

experiment's data.

To continue the experiment, modifY a setting as per experiment design, then

optionally add a comment, select the enviromnent page and then press the Take Picture

button. A new photograph is produced.

Standard interface buttons are provided to view the completed pictures in a Full

screen or Actnal size Windows. These buttons are available in the Offline viewing mode

as well.
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8.3 Image Quality

. The software uses place the camera in JPEG mode although if software image·

processing is required a propriety raw fonnat is available. The JPEG mode was chosen

because the compression used reduces the file size considerably without noticeable image

quality degradation. The small file sizes means downloads from the camera to the PC is

relatively short. The 4.1 mega pixel, C4040Zoom camera from Olympus provides

excellent detailed pictures. There is however, room for improvement and a better quality

camera can be used. The most stringent requirement for a different camera would be that

it is controllable via software, preferably through an USB interface.

The actual image size is 2272 by 1704 pixels. This is considerably more than

most desktop PC settings thus, a means for viewing either the full screen image or the

actual size image was introduced. Standard setting of 72 DPI is used for both horizontal

and vertical resolutions.

8.4 Real World Experimentation

The device performs admirably as the following sequence of seven

photographs with its associated data show. This was first of a series of sample

experiments produced with most of the functional elements device in working

order. There are a number of points of interest. Firstly, the time span of these

pictures was a little over 20 minutes. The first was taken at 21:\9 and the last at

21:40, in 21 minutes six successful photographs were taken all with immediate
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feedback. The photographs show an increase of corona discharge as the frequency

is incrementally decreased. This increase of corona is most like due to the

frequency of the device approaching the resonant frequency of the leaf and TLE

combination.
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Figure 8-1: Kirlian photograph of uperiment "TestIIighVoltages6~
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FIgUre 8-3: Kirlian photograph .reIperimellt "TestHighVoluges7"
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Figure~: Kirlian photograph of experiment "1'estHigbVoltagall"
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Fq:are 8-7: Kirlian photograph orexperiment "TestBlghVoJI1Ign9"
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YIgllI'e8-11: KirIian photograpb .re.perimellt "TntHighV.Jtogesl3"
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Figure8-13: Kirlian photograph orexperim...t .....estHighVolt.gesI4"
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8.5 Safety Precautions

The instrument was designed with inherent safety aspects. These included the full

Galvanic isolation of the high voltage generation circuitry. This provided flashover

isolation of 1500V from the low voltage side. The maximum current was limited on

secondary to 5mA this is twenty times less than what could be considered a dangerous.

Caution typified the initial human experiments as time progressed however

confidence grew in the ability to produces instant quality Kirlian pictures and in the

safety aspects of the device. One aspect requires further attention is the high voltage lead

is some what exposed and requires the operator to make sure human subjects do not come

within lOcm of this tenninaL

8.6 Conclusions

Conclusions' resulting from this chapter refers to the overall instrument and it is

therefore discussed in the following chapter.



CHAPTER 9

CONCLUSIONS AND RECOMMENDATIONS

9.1 Introduction

This dissertation is based on the design and practical construction of a prototype

.instrument, which can be used in research of the Kirlian photographic phenomena. The

focus has been on using modem design techniques to provide reliable scientifically valid

research results.

An integrated design was chosen to provide an empirical view when undertaking

research. The device consists of a number of engineering systems that require synthesis.

Each one of these tasks by them selves was not particularly difficult. Neverthdess, as far

as is known, this is the first time a Kirlian photographic instrument with these features is

envisaged and assembled.

9.2 Problems Solved in the Dissertation

The problem that this dissertation was required to solve was design and

construction of a Kirlian photographic device was can be used in firthering research on

this matter. This problem was divided into many sub-problems, which is described briefly

in the following sections.

lQl
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9.2.1 Environment Parameters

This task required selecting, from numerous possibilities, environment conditions

to monitor. A personal interview with a leading expert was conducted as well as a

literature review was done. The five, measurands were selected namely; ambient

temperature, humidity, barometric pressure, background light levels as well as the object

pressure. All of these measurements were implemented except that of object pressure

which not because of time constraints. Appropriate sensors were selected and the

required electronic circuitry was designed and constructed. A method of implementing

alarm levels via software was also conceived.

9.2.2 Portable Photographic System

This task required the design and implementation of a portable photographic

system that would allow taking of pictures without the aid of a darkroom. A Transparent

Liquid Electrode (TLE) was crafted which enabled a digital camera to take Kirlian

pictures. Near instant Kirlian pictures were produced, facilitated by the digital camera

selected.

9.23 Microcontroller System

This task required the design, implementation and programming of

microcontroller system that facilitates the communication of instructions from the

personal computer (PC) software to the rest of the instrument. This system, based on an

existing design, it collects all of the analogue and digital data from the instrument as well

as setting the parameters of the high voltage system.
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9.2.4 High Voltage System

This task required the design and implementation of a high voltage supply that

can be controlled from a microcontroller. Galvanic isolation was provided between the

high voltage supply and the microcontroller. The microcontroller provides the signals

required to configure the frequency and voltage.

9.2.5 Computer Program

This task required the design and programming of a computer program which

provides the operator with an experimenter centric view of the research. A profile of

experiment conditions can be stored and recalled by the operator. It also provides an

offline mechanism so that other parties via the internet or other software distribution

methods could view the completed experiments. A completed experiment contains the

Kirlian picture as well as the conditions of the experiment.

9.2.6 Integrating the Engineering Systems

This task required the integration of the above engineering systems into a

synergistic design that makes practical sense. A portable light-tight wooden box was

designed and constructed to contain these systems except the software program of course

which is executed on an external personal computer (PC). This design also implements an

easily removable cover with a light tight sleeve which allows a picture to be taken of a

human hand.
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9.2.7 Performance ofthe Instrument

The final task required the testing of the device. All engineering systems were

implemented as discussed. The working prototype is in the main completed. It is

currently housed in the Information Technology (Academic) department at the Peninsula

Technikon. It progress can be tracked by visiting the http://www.pentech.ac.zalsvdwell

website.

The instrument proved reliable and robust, through three months of testing and

demonstration. Excellent quality pictures are produced. The true potential of the device is

at the moment undiscovered and will require further investigation.

9.3 Recommendations for Further Study

It can be said with reasonable confidence that this device opens up many research

avenues. There are countless researchers, in this field, who strived that their sometimes

controversial results could be duplicated [Moss, 1981]. This instrument or others using

these design techniques could provide the validation required. There are obviously still

contentious areas and finding significant result might be elusive even with this device.

Techniques such as fractal. matrix and probability analysis might ultimately be needed to

validate the efficacy of the instrument as done by ether researchers [Korotkov, 2001].

The design approach outlined in this research is an honest attempt to reinvigorate

discussion, debate and more importantly experimentation surrounding the Kirlian

photographic phenomena



APPENDIX A
LISTING OF MICROCONTROLLER CODE

;'
Kirlian Project 2001
Author: Sydwell Williams
Date: 07 June 2001

Version: D06
Revision Date: 05 July 2001

NB!! !!!!!!!!!!! !!! This code must be Linker @ location at Oh

Implementing correct total Time Periods

o
1
2
3
4

5
5
7
8
9
10
11
';

10
20
50
100
200
500
1
2
5
10
20
50

milliseconds
milliseconds
IIlilliseconds
milliseconds
Illilliseconds
milliseconds
second
seconds
seconds
seconds
seconds
seconds

tpragma DEBUG OBJECTEXTEND CODE
#include <reg515.h> I~ special function register declaracions
iinclude <ctype.h>
ipragma REGISTERB~~ (O)
*define TRUE 1
idefine FALSE 0
#-define check_ok 'r'
#-define comms_check 'c'
#define dump_data 'd'
'define get_set_values 'g'
~de£:ine testing 't'
#defi.:le take-pic-:.ure \p I

axcern char getkey ();
extern char putcnar (char)

i:lt DigitalOP
str16 C~C

sfr:6 Cr',

(char
Oxc..~;

OxC2;

pi~, bic value);
16bit compare reload a~d ca9c~re s=~, t~mer2

The first Capture and Compare sfr, ~~mer2

105



/1 Produces a fixed frequency of 5Khz
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sbit shutter_dop P4'1;

sbit waveType_dop P4'2;
sbit groundl_dop ~ P4"'3;
sbit ground2_dop P4'4;
sbit safety_din ~ P4"'5;
sbit DtoA_dop P4'6 ;
sbit fre<L-dop ~ P4'7;

char temperature, pressure, light, humidity, teste, time;
unsigned long total_time-periods, time-periods;
bit debug :::: ~~SEi If Debug information during run
time

*pragma REGISTERBANK ID)
void timerO (void) interrupt 1 using 0
{

time-periods++;
fre~dop=!fre~dop;

}

#pragma REGISTERBANK (0)

char GoodData {char
{

int i, sum=O;
ADM~D; //

ADCON&~DxF8;
ADCON I~port;
for (i=Oi i<6;

port)

Single conversion
/1 Clear old port
/1 Select port

i++)

settings

DAPR~DxDO;

while IBSY);
sUIn+.::ADDAT;

}

return (sum/6) i

int loop (void)

If Start conversion
/1 Do nothing till end of conversion

ground2_dop=1;
If while (TRUE) putchar ('L');

inc GetAllData (void)

if (debug) putchar ('D');

temperature; GoodData {O);

pressure GoodData (l);

light GoodData {Z}
humidity GoodData (3)
~et:.lrn (TRUE);

inc CommsError (void) //char *"message)
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putchar ('E');
groundl_dop=1 ;
//printf (n\n\n CO~ err \n\t%s·, message);
return (FALSE);

int SetValues (void)

char voltage, ground, shape;
unsigned int frequency;
int fre~l, fre~h; /IShouldn't be char as well
int first=O i

1/ Remember the Low Nibble selects

// Freq high byte
If The number of lOOus time periods

If groundl_dop=O;
safety_din=l;
DtoA_dop=O;
if (debug) putchar ('g');
voltage = getkey ();
in :£<Volts
P5==-volt.age;
Voltages
fre~l = getkey ();
reload
fr~h = getkey ();
time= getkey ();
needed
switch (time)
(

/1 Voltage output to be generated

// Frequency Low byte rem counter

case OxOg, total_time-periods 100; break;
case OxOA, total_time-periods = 200; break;
case OxOC, total_time-periods 500; break;
case Oxll , total_time-periods 1000 ; break;
case Ox1.2 : total_time-periods 2000; break;
case Ox14, total_time-periods 5000; break;
case 0x21, total_time-periods 10000; break; II!
case Ox22, total_time-periods 20000; break; 11"
case 0x24, total_time-periods 50000; break; 11$
case Ox4l: total_time-periods 100000; break; IIA
case Ox42, total_time-periods 200000; break; liB
case Ox44: total_time.....,periods 500000; break; I iD
default: total cime-periods = 70000;

ground=getkey (); II Get the type of groundi~g

shape=getkey ();
Ilhumidity=voltage; / I Testing
frequency = (fre~h*OxlOO) + fre~l;

CRC = Oxl0000 - frequency;
CCl = OxlOOOO - (:requency/2);
//P5=humidity;
return (TRUE);

int TakeSnap (void) !I a p~cture will be ta~en



/1 Enable Timer 0 interupt
If start timer 0

108

ETa ~ 1;
TRO :; 1;
time--periods:=.O;
if (debug) putchar ('AI);
/J testc=getkey();
shutter_dop =1; // Switch shutter output on
while (time-periods < (total_time-periods)

I/total_time-periods)

if (debug) putchar ('W');

If Do nothing remember
jjinterupt timer routines will be serviced

}

TRO 0;
if (debug) putchar (') ');
shutter_dop = FALSE;
putchar ('P');

int Test (voidl

putchar (' t' ) ;
CCH3~Qx60;

waveType_dop=!waveType_dop;
ground2_dop=O;
groundl_dop=O;
shutter_dop=O;
safetY_din::.O;
DtoA_dop::::O;
return (TRUE);

/**
main program starts here
*/

void main (void)

/ / stop timer 0

/1 Switch shutter output off
1I Send Acknowledgement to PC

char received_instruction = 0;
ine inst= 0; if Number of instructions
char temp_lowbyte=O,
press_lowbyte~OJ

humid_lowbyte~OJ

light_lowbyte~O;

/* The following three comm~~ds set she Cornms as follows
Baud rate 9600
Data Bits 8

stoP Bits
Parity none
xl

SCON Ox56; If SCON: mode 1, 8-bit DART, enable rcvr
changed from Ox54



PCON : Dx8D;
ADCON : DxCD;
/ I and eLK output
IEND ::; 0;
IENl D;
EAr.. 1;
P4 DxDO;
PS OxOA;
THO Ox9C;
TLO : Ox9C;
counts interupt

TMOD : 0x22;
ground2_dop = 1·
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If SMOD bit of PCON set to double frequency
If Standard Baud Rate used, BD Set
set ON

If Disable All interrupts
1/ Enable all interrupts Global switch
If Clears Port 4
If Port 5 to switch DA on, outputting 14.12v

I1 Timer 0 reload 100 counts: lODuS
If remember counts from 9C to FF or 100

/1 timerO and 1 in mode 2
If Indication that micro is working

/1 printf ("\n \n All well that is, sydwell
putchar (\ D' ) :
putchar (. 0' ) ;

putchar ('6');
putchar (. ');

\n"} ;

11 Setup Timer2 for Frequency Generation
/1 Frequency Out from CCl - level changes at counter overflow and
at ceLl & CCHl = counter TL2 & TH2
// Signal Available at Pl.l also known as K8
T2CON=Oxll; // luS autoreload timer compare mode 0
// timer function selected T2CON.O=T2IO=1 and T2CON.l=T2Il=O
// reload mode selected T2CON.3:T2RO:O and T2CON.4:T2Rl:l
If compare mode 0 T2CON.2=T2CM=O
// prescaler not used T2CON.7=T2PS=O
CCEN=OxAA;// Compare enabled on all compare/capture registers CC
// testing timer2
CCHl : OxFF;
CCLl : OXFE;
eRe = OxFFFD;
CCH2:0xEO;
CCH3:0xAO;

Get...?;.llData ();
while (received_instruction != 'Q')

received_instr~ction= getkey ();
if (debug}

putchar ('R');
putchar {received_instruction);

)

switch (received_instruction)

case comms check: Dutchar (check_ok) j break;
case dump_data: putchar ('I'}; putc~ar (t~~peraturej

putchar (pressure); pucchar (:ight); pucchar
(humidity) ;
pucchar {'9'}; DtoA_dop~l; safety_din=O; brea~;

case get_set_values: SetVal~es (): ~reak;

case \ l': loop (); break;
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case take-picture: TakeSnap (); break;
case testing: Test (); break;
default: CommsError {}; //~Invalid instruction H

);

}

GetAIIData ();

/1 printf ("Kirlian 80C535 Halted By esc Please Reset 6
);

while (TRUE)
(

If Endless loop
)

/lputchar (. Q' ) ;

1* END OF MICROCONTROLLER CODE *1



APPENDIXB
liSTING OF SOFTWARE CODE FOR MAIN-FORM

/**********************************************************************

*
*
*
*
*
*

Project:
Author:
Date:
Version:
Revision:

Kirlian Experimenter
Sydwell Williams
2013/2001
1.27
05/05/2003

* Currently: When setting up camera, use cam2corn to set initial
shutter speed

First Publicly Demonstrable Version

*
*
*
*
*
*
*

.1 Corrected Previous Displayed Picture

.2 Store Experiment Results in Folders Only

.3 Working Exception Handling Demostratored

.4 Fixing File location issues

.5 Include true fullscreen views - Document aspect ratio issue

.6 Corrected Displayed Picture

* 1.21.0
* Major rewrite Olympus SDK used to control camera
* optical Zoom issues Ok
* 1.22
* Changed Automatic Naming to DON
* Fixed Preview bug
* Still to check And Error return codes
* What about a fixed powersupply ?
• 1.23

Major error condition displayed - OK
* Changed Status Panels - OK

Still to change Last Picture to work ~~der restarted conditions

*1.24
Click Camera for Ca~era Status Enabled

*1.25
Fixed problem with rereading directory lisring

*1.26
Last Pic~ure screen show lasr Picture now ~~d bugs fixed

*1.27
Drive box for Kirl.i.an Dara V:"eTa window
Er=or decection if PublicK.jpg not found

III
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I
#include <vcl.h>
#pragma hdrstop
#include ~K2001Main.hR

#pragma link "RYELib_OCX·
-lfpragma link "RYELib_OCX"
#pragma resource .w.dfm"

TK2001Main_f *K200LMain_f;

11---------------------------------------------------------------------
1****************************************/
1*
1*
1*

NEW SECTION
1

Main Routines

*1
*1
*1

void

I***k***k********************************/

fastcall TK2001Main_f::FormCreate{TObject *Sender)

* 1.1
*

Code runs when form is created

*
*
*

Arguments:
Effects:
Return:

Gur designer TForm
Iniatializers the main form
void

******************************************************************/

StartUp : true;

If K2001Main_f->Visible
}

II

II
1/

false;

True during the Startup Process
When Debugging leave as false

void __fastcall TK2GOIMain_f::FormActivate(TObject *Sender}

* 1.2 Code runs when form is Activated
*
*
*
*

Arguments:
Effects:
Return:

GUI designer TForm
Activates the main form
void

I

if (StartUp)

Splash_f->WindowScate = wsNo~al;

Splash_f->ShowModal{);
K2001Main_f->Visible = true;
StartUp = false;

__fastcall TK2001Main_!: :TK2001Main_£{TCompcnent *OwTIer!
TForm(Owner)
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1***************************************************** *****************

* 1.3 The Constructor for the main form

*
*
*
*

Arguments:
Effects:
Return:

Gur designer TForm
Constructor the main form
void

/
(

}

//

HouseKeeping()i
LoadExperimentTemplate(~default·);

void __fastcall TK2001Main_f::HouseKeeping(void)

* 1.4 Important housekeeping done here

*
*
*
•

Arguments:
Effects:
Return:

void
Setup Appearance, Initialisers Global Variables
void

***********************************************************************

/
(

K200LMain_t->Height=570i
K2001Main_f->Width=800;
K2001Main_f->Top=1;
K2001Main_f->Left=1;
isTimerRoutineRunning : false;
Main-pagectl->ActivePage=LastPicture_tabsht;

active Page
TakePicture_but->Font->Sty1e ~ TFontStyles()« £5Bo1d;;
TakePicture_but->Caption~~ActualSize Picture~;

K2Q01Main_f->Color=clAqua;
Environment_tabsht->Brush->Color;clTeal;
RTCamera_tabshC->Brush->Color;clTeal;
LastPicture_tabsht->Brush->Color=clTeal;
baseTitle; • THE KIRLr_~ EXPERIMENTER -~;

11/ StatusBar->Color=clYellaw;
//1 StatusBar->Font->Colar=clTeal;
III StatusBar->Font->Style;TFontStyles()« fsBold;
III StatusBar->Font->Size=lO;

/1 Set the

I~ Set Initial Gabal Variables rl
CommsTestBAD = true;
SetCommPort,CGMM1} ;
K200LMain_f->Menu = Mair~enul;

EnableHVwithoutCamera->Checked = tr~e;

Pic~ureRequested ; false;
FileNameKET = "Default";
ProgramCurrentDir = GetCurrentDir();
carneraNo :::; 0; 1/ Will create a problem i£ there is ,flare t:J.an

one USB CaID.era car~ected

~ ':"" (FileExists (" fresh. jpg.)) DeleceFile (" fresh. jpg") '/Makesure
downloaded =~le doesn't exist



'r' ;

= 'c' ;

'd' ;
'g' ;

= 't' ;

'p' ;
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/1 This mess up the Script path consider cmdline ParamStr(O)
BaseDataDir ~ ProgramCurrentDir + ~/IDefault~;

pollCount 0;
checkRok
commsCheck
dataDurop
Get_set_values
Testing
takePicture

j* Load initial picture and configure
PreviousPic_jp = new TJPEGlmage()

need?
DataView-:jp new TJPEGImage ()
try
(

its size *1
/1 Is two TJPEGImage '5 really

PreviousPic.-:jp->LoadFromFile (·PublicK. jpg" )
DataView_jp->Assign(PreviousPic~p);

Image2->Picture->Assign(DataView_jp)
Image2->Stretch = true;

catch (const Exception &e)
(

Application->MessageBox(" No Previous Picture \"PublicK.jpg\"
NULL, ME_OK);

}

/* if (CameraCheck())

CameraPanel->Color=clLime:
CameraPanel->Caption="CAMERA STATUS: COIL~ected·;

} else
{

CameraPanel->Colar:clRed;
CameraPanel->Caption=-C~~STATUS: Disconnected-;

} ';
} Ilendmethod HouseKeeping
;;

void __fastcall TK2001Main_f::Main-pagectlChange(TObject *Sender)

~ 1.5 Display different main button for different pages,
,

main

ll..rgu...rnents:
Effects:

form
Return:

GUI designer page control
Show the various pages on

void

clicked
the main panel on the

/ITPageConcrol
,= (¥~in-pagec~:->AccivePage ~= L~viror~ent_tabshc)

TakePicture_buc->Font->Style = TFoncStyles()« fsBold;
TakePlcture_out->Capcion="Take a Piccure";
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TakePicture_but->Enabled ~ true;
FullScreen_but->Visible ~ false;

}

if (Main-pagectl->ActivePage == RTCamera_tabsht)
{

TakePicture_but->Font->Style = TFontStyles{}« fsBold;;
TakePicture_but->Caption = UActual Size Pictureu;
TakePicture_but->Enabled = false;
FullScreen_but->Enabled false;
FullScreen_but->Visible = true;

}

if
{

(~~in-pagectl->ActivePage LastPicture_tabsht)

}

11

TakePicture_but->Font->Style = TFontStyles{}« fsBold;;
TakePicture_but->Caption = BActual Size Picture B

;

TakePicture_but->Enabled = true;
FullScreen_but->Enabled = true;
FullScreen_but->Visible = true;

void __fasteall TK2001Main_f::NoCameraView_butClick{TObject ·Sender)
I*******************************~~*************************************

* 1.6 The camera view page

*
*
*
*

Arguments:
Effects:
Return:

GUI designer Camera view panel button clicked
Display Environment Panel
void

I
(

}

11

Main-pagectl->ActivePage=Environrnent_tabsht;
TakePicture_but->Font->Style = TFontStyles{}« fsBold;
TakePicture_but->Caption=-Take a Picture-;

void __fastcall TK2001Main_f::TakePicture_butClick(TObject ·Sender)

* 1.7 What happens when the Take Picture button is pressed

p-..rgument.s:
Effects:

but.t.on is clicked

GDr designer Take Picture button clicked
H~~dle all the conditions as che Take Picture

bJ If the Displayed panel is Environment, Attempt
full-size gicture

to take a picture

a) the Displayed panel is Lastpicture, display

change
Return:

c) At~~~pted picture spawn a external program,

void

while lisTimerRoucineRunning)
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Labell->Caption = Rtimer R;/* Do Nothing this label is not visible
*/

K2001Main_f->Repaint():
PollRoutine->Enabled ~ false; /IStop the timer routine

TJPEGImage *jp = new TJPEGImage();
if (Main-pagectl->ActivePage == LastPicture_tabsht)

FullScreen_f->Imagel->Height=FullScreen_f->Imagel->picture­
>Height;

FullScreen_f->Imagel->Width=FullScreen_f->Imagel->picture->Width;
/* FullScreen_f->Imagel->Height=Screen->Height;
FullScreen_f->Imagel->Width=Screen->Width;*;
FullScreen_f->Imagel->Stretch = false;
FullScreen_f->Height = Screen->Height;
FullScreen_f->Width = Screen->Width;
FullScreen_f->BorderStyle = bsSizeable;
FullScreen_f->ShowModal() ;
PollRoutine->Enabled=true:

)
if
{

(Main-pagectl->ActivePage

if (CameraCheck())
{

Environment_tabshtl

// Just take the picture NB!! camera must be correctly setup
int err:
SetCurrentDir (programCurrentDir);
Camerapanel->visible = true;
CameraPanel->Color=clLime:
Camerapanel->Caption=-CAMERA STATUS: Connected-;
PictureInProgress_b->Visible = true;
PictureInProgress_b->Caption = -High Voltage now enabled-;
PictureInProgress_b->BringToFront();
K2001Main_f->Repaint(};
long numPicCanTake = Ryel->propRemainCount(O};
if (numPicCanTake < 1)
(

Application->MessageBox(-Not.enough space on camera card to
take picture-, NULL, MB_OKCk~CEL) != lDOK;

)
Ryel->propFlash[Oj = RYE_FLASH_OFF;
Ryel->propFocusMode[O] = RYE_FOCUS_~~~AL;

Ryel->propWhiteBalance[OJ = RYE_WB_DAYLIGHT;
Ryel->propElectricZoom[OJ = RYE_EZ_OFF;
Rye1->propExpoBias[O] = 0;
if (ZoomWide->Checked) Rye1->propOpticalZoom[Ol = 1;
if (ZoomNormal->Checkedl Ryel->propOpticalZoom[O] = 100;
if (ZoomTelephoto->Checked) Ryel->propOpticalZoom(Ol = 225;
Ryel->SetExposurePropVB(O, RYE_EXPOSURE_~~AL,

ki~fo.getFStopValue{), 1000 ~ kinfo.getExposura~illseconds(});

K200L~ain_f->Ryel->propI50Speed[Ol= kinfo.ge~Sens~tivi~y() T.­.,
K200L~ain_f->Rye1->propFocusPosition[O] = kinfo.getFocal()

15;
/!Y~ke sure Program DirectorJ
pictureRequested = true;

Righvoltage source

is the current cirectory
If Sets flag co enable
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Sleep(200);
PollRoutine->Enabled ~ true;

/1 Camera takes picture Now
PollRoutine_timer(this); /1 Force the taking of timer

If Disable the Pollroutine until

routine
PicturelnProgress_b->Caption
while (isTimerRoutineRunning){

Nothing */};
PollRoutine->Enabled=falsei

a picture is taken

Ryel->Capture(O) ;
PictureInProgress_b->Caption =

Image-;

~Nown; K200lMain_f->Repaint(J;
Labell->Caption = -timern;f* Do

·Please wait while transfering

K2001Main_f->Repaint{) ;
{ /IThis block of code downloads the image from the camera

long noOfPics = Ryel->propPicCount[O];
Ryel->propCurrentpicture[Oj = noOfPics;
const long nPicSize = Ryel->propPicSize[O];
Variant V (OPENARRAY (int, (O,nPicSize-l)},varInteger);
TVariant PicTV = new TVariant(V};
TMemoryStream* picStream = new TMerooryStream();
Ryel->GetPicture(O.nPicSize,PicTV~intVal)
int *picBufferi
if ((picBuffer = (int *) malloc(nPicSize» NULL}
(

Application->MessageBox{-Not enough memory in RAM for
JPEG image", NULL, MB_OKCA.~CEL) != IDOK;

exit{~); 1* terminate program if out of memory */
}
picBuffer ={int *} VarArrayLock(PicTV};
picStream->position = Oi
picStream->Write{picBuffer, nPicSize);
picStream->position = 0;
picStream->SaveToFile(-fresh.jpg-) i

picStream->Free(} ;
Ryel->EraseLast(O}; /1 Erase the picture in

the camera
Ryel->propPowerSaveHost[OJ
Ryel->DisConnect{O) ;

30; IICheck this

11 Create a JPEG object assign it to a Image2 to display it!
while (!FileExists{-fresh~jpg~) {/* Do Nothing */};

jp->LoadFromFile(·fresh.jpg~);
Image2->Picture->Assign( jp )i
Image2->Stretch = true;
kinfo.setDateTime(};
FullScreen_f->Imagel->Picture->Assign( jp );

Save data in file
//TFileStream ~KData2Save;

int iFileHandle;
iFileHandle = Fil&Create (BaseDataDir + ~\ H ~

kin£o.getPictureFile() + ·.KPD~) j

FileWrite (iFileHandle. &kinfo, sizeof(kinfo));
?ileClose{iFileHandle) ;
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jp->SaveToFile{BaseDataDir + "\\" + kinfo.getPictureFile() +

•. jpg");

/1 PreviousPic_jp->Assign(jp); this was commmented out in
version 1.27

getKDataFilename (); /1 get the new filename
DisplayKInfo{kinfo); // Diplay the new info
if (FileExists("PublicK.jpg"» DeleteFile ("PublicK.jpgR);
if (FileExists("fresh.jpg"» RenameFile(Ufresh.jpg",

"PublicK. jpg") ;

PictureInProgress_b->visible = false;
Main-pagectl->ActivePage = LastPicture_tabsht;
Main-pagectlChange( Sender );
/ / jp->Close(); */

} If endif CameraCheck
else

CameraPanel->Visible = true;
CameraPanel->Color = clRed;
CameraPanel->Caption = ·CAME!L~ STATUS: Disconnected";
if (EnableHVwithoutCamera->Checked && !CommsTestBAD)

pictureRequested = true;
Camerapanel->Visible = true;
CameraPanel->Color=clYellow;
Camerapanel->Caption=-CAMERA STATUS: Disconnected but hv

enabled- ;
IIIStatusBar->Color=clOlive;
II/StatusBar->Panels->ItemsIO)->Text=-COMMUNICATION: High

voltage Enabled -;
}

} II endelse CameraCheck
PollRoutine->Enabled=true;

} II endif Main__oagectl->ActivePage
1/ endmethod TakePicture_butClick

void __fasteal1 TK2001~~in_f::getKDataFilename(void)

* 1.8 Get the appropriate Filename

Arguments:
* Effect:.s:

and Picture filename
Return:

void
TakePicture_butClick handle~ to create a new Data

void

AnsiString nam3, Wstr = FileNameKET; II a working string
int pes = Wstr.LasL~elimiter(a\\8};

Wstr.Deletel 1, pes);
pes = Wstr.LastDelimiter{ a.a );
Wstr.Delete( pes, Wstr.Lengtn(} ); If Make sure Ne have t~e =aw

::ilename
for (int n = ~; __ < 1000; n~Tl
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if (n > 99) nam3 = Wstr + n;
else

if {n > 9} nam3 = Wstr + wQ~ + n;
else nam3 = Wstr + ·00· + n;

if ( !FileExists(BaseDataDir + n\\_ + nam3 + n.KPDA) ) break;
}

kinfo.setPictureFile (namJ);
} //method getKDataFilename
1/

void __fasteall TK2001Main_f::DisplayKInfo{KDataClassl DInEo)

* 1.9 Display drre Kirlian data in the Environment Tabsheet

*
*
*
*

Arguments:
Effects:

Return:

KDataClassl
Called when a new templates is loaded

a) NIY stands for Not Implemented Yet
void

***********************************************************************
/
{

this->Caption = baseTitle +. Template =. + FileNameKET;
FileName_ed->Text = DInfo.getPictureFile{};
Template_memo->Lines->SetText(

DInfo.getExperimentTemplatecomment() .c_str() );
Experiment_memo->Lines->SetText{ DInfo.getPictureComment{) .c_str()

) ;

Voltage_ed->Text = Dlnfo.getVoltage();
Voltage_ud->Position ~ Dlnfo.getVoltage();
if ( 1000 > Dlnfo.getFrequency()}

Frequency_ed->Text = Dlnfo.getFrequency();
Labe122->Caption = ~Hz~;

} else
(

Frequency_ed->Text = Dlnfo.getFrequency()/lOOO;
Labe122->Caption = -kHz-;

)

Frequency_ud->Position = DInfo.getFrequency{}/lO;
Ground_cbx->Itemlndex = Dlnfo.getGround{};
Exposure_cbx->Itemlndex = DInfo.getExposure();
Lens_ed->Text = DInfo.getLens();
Focal_ed->Text = DInfo.getFocal{};
Focal_ud->Positicn = Dlnfo.getFccal();
Sensitivicy_cbx->Itemlndex = Dlnfo.getSensitivity();
FStcp_cbx->ltemlndex ~ DI~fo.getFStop();

MinTemp_ed->Text = Dlnfo.getMinTa~p() i

MinTemp_ud->Position ~ DInfo.getMinTemp();
IJNIY MinALmPress_ed->Text = Dlnfo.geL~inPress();

.I /NIY MinAt:rlPress_ud->Position = D1:1£0. gec.MinPress ( ) i

MipLight_ed->Text = Dlnfo.getMinLight();
MinLight_ud->Position = Dlnfo.getMinLight();
Mi~qumid_ed->Text = Dlnfo.getMir~umid() i

MirrEumid_ud->?osition = D1nfo.geG~inHumid();

NIY MinObjP~ess_ed->Text = Dlnfo.getMinOpress()
INIY ~i~ObjP~ess_ud->?osiLion= Dlnfo.getMinOpress(i;
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MaxTemp_ed->Text = Dlnfo.getMaxTemp():
MaxTemp_ud->Position = Dlnfo.getMaxTemp();

IINIY MaxAbmPress_ed->Text = DInfo.getMaxPress{)
IINIY MaxAbmPress_ud->Position = Dlnfo.getMaxPress();

MaxLight_ed->Text = Dlnfo.getMaxLight();
MaXLight_ud->Position = Dlnfo.getMaxLight();
MaxHumid~ed->Text = Dlnfo.ge~~xHumid{);

MaxHumid_ud->Position = Dlnfo.getMaxHumid{);
IINIY MaxObjPress_ed->Text = DInfo.getMaxOpress();
IINIY MaxObjPress_ud->Fosition = Dlnfo.getMaxOpress();
} // endMethod DisplayKlnfo
11

void __fastcall TK2001Main_f::pollRoutine_timer{TObject *Sender)
1***************************************************** *****************

* 1.10

*
Timer routine accessed every 1000 ros (I second)

appropriate

*

appropriate colours,

*
*
*

*

Argu..rnents:
Effects:

GUI designer Timer routine
This is the timer interrupt handler
a) Communicates with the micro and displays

diagnostic information
b) Displays the environment variable in the

*
the KET

*
the KET

KET

*
not active

*

Blue if the variables are within range of in

Green if the variables are below range of in

Red if the variables are above range of in the

c) This routine is disabled when the main form is

* Return: void

I
{

char
AnsiString
DWORD
DWORD

*receivedBuffer =
sendGetsetBuffer;
nBytesToWrite =1,
nBytesWritten=3,

new char[20}, exposureChar;

nBytesToRead=6;
nBytesRead=2 ;

int fre~eriod; Ilin Micro seconds
char £re~highbyte, fre~lowbyte, exp_lb, exp_hb;
char rxChar, voltage_byte;
int errno;
int totalExp;

isTimerRoutineRup~~ing= true;
K2001Main_r->Repaint(} ;
receivedBuffer=~623456g;

if (pollCount == 0) KE~odified

modified, can 8nly be placed here
pollCount++;

absolutely necessarJ

raise: Templaee is noe

/1 General variable, not
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if (pollCount == MAXLONG) pollCount
throe 0

if (CommsTestBAD)

1; /1 Prevent loop counting

&nBytesWritten, NULL};
in WriteFile-) ;

(hCom, PURGE_TXABORT)
(hCom, PURGE_RXABORT);
(hCom, PURGE_TXCLEAR);
(hCom, PURGE RXCLEJI.R) ;
ShowMessage(-Error in PurgeCornm-);

{ ShowMessage(-Error in ReadFile-);

to receive data dump
(hCom, &dataDump, 1,
{ ShowMessage(-Error

/ /NIY

/ /NIY

/ /NIY

/ INIY

/* Display Error Defaults */
- ActTemp_ed->Font->Color=clRed;

ActAtmPress_ed->Font->Color=clRed;
ActHumid_ed->Font->Color=clRed;
ActLight_ed->Font->Color=clRed;

ActObjPress_ed->Font->Color=clRed;
ActTemp_ed->Text = -Not Available-;

ActAtmPress_ed->Text ~ -Not Available-;
ActHumid_ed->Text = -Not Available-;
ActLight_ed->Text = -Not Available-;

ActObjPress_ed->Text = -Not Available-;
SetCommPort (ActiveCommPort);

}else If endif CommsTestBAD
{

!/Purge all outstanding comms commands and buffers rem timeouts is
effective

errno = PurgeComm
errno PurgeComm
errno PurgeComm
errno Purgecomm
if (errno == 0) {

CommsTestBAD=True; }
// Write to Comm Port

errno=WriteFile
if (errno == 0)

CommsTestBAD=True; }
/1 Read the data dump Comm Port

errno=ReadFile (hCom, receivedBuffer, nBytesToRead, &nBytesRead,
NULL) ;

if (errno == 0)
CommsTestBAD=True; }

Labell->Caption=-receiving-;
if (receivedBuffer[O]!= 'I')
{

CommsPanel->Color=clRed;
CommsP~~el->Caption=-COMMU~ICATION:Cannot read2 state R

;

CommsTestBAD=True;
}

kinfo.setActTemp{ O.32~posit lreceivedBuf:er[l]) - 7 );
kinfo.setActPress( posit (receivedBuffer[2}) );
kinfo.secActHumid( posit (receivedBuffer[3]) 1;
kinfo.seCActLight( posit (receivedBuffer[4]) );
kinfo.setActOpress( posit (receivedBufferC511 )
receivedBuffer[51= posit (receivedBuffer[6]) 7 /1 Shou:d al~ays

be '9'

/Y Display Colours ". /
AccT~~p_ed->Text=kinfo.geL~ctTa~Pl) ;
if ({ kinfo. getActTemp () >=

ki~£o.getMinT~~p(»)&&\kinfo.getActTemp() <~ kinfo.gecMaxTemp\
ActTemp_ed->Ponc->Co:or=clBlue7
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if (kinfo.getActTemp() < kinfo.getMinTemp(}) ActTemp_ed->Font­
:::>Color=clGreen;

if (kinfo.getActTemp{) > kinfo.getMaxTemp{» ActTemp_ed->Font-
::>Color=clRed;
!*NIY ActAbmPress_ed->Text=kinfo.getActPress{);

if ((kinfo.getActPress() >=

kinfo.getMirtPress(}}&&(kinfo.getActPress() <= kinfo.getMaxPress(}»
ActAtmPress_ed->Font->Color=clBlue;

if (kinfo.getActPress() < kinfo.getMinPress(» ActAtmPress_ed­
:::>Font->Color=clGreen;

if (kinfo.getActPress() > kinfo.getMaxPress(» ActAtmPress_ed­
:::>Font->Color=clRed;
*/

ActHumid_ed->Text=kinfo.getActHumid()
if ((kinfo.getActHumid() >=

kinfo.getMinHurnid() l&&{kinfo.getActHumid() <=
kinfo.getMaxHumid(»)ActHumid_ed->Font->Color=clBlue;

if (kinfo.getActHumid() < kinfo.getMinHumid(» ActHumid_ed->Font­
;.-Color:=clGreen;

if (kinfo.geL~ctHumid() > kinfa.getMaxHumid() ActHumid_ed->Font­
>Color:=clRed;

ActLight_ed->Text:=kinfo.getActLight() ;
if ((kinfo.getActLight() >=

kinfo.getMinLight(»&&(kinfo.getActLight() <:= kinfo.getMaxLight())
ActLight_ed->Font->Color:=clBlue;

if (kinfo.getActLight() < kinfo.getMinLight()) ActLight_ed->Font­
>Calor:=clGreen;

if (kinfo.getActLight() > kinfo.getMaxLight(» ActLight_ed->Font­
>Color:=clRed;

/1 Send Device parameter to Micro via serial port
errno := TransmitCommChar (heam, Testing);
if (errno == 0) { ShowMessage(-Error in TransmitCammChar

Testing-); CommsTestBAD=True; }
errna=ReadFile (hCam, &rxChar, 1, &nBytesRead, NULL);
errna=ReadFile (hCam, &rxChar, 1, &nBytesRead, NULL);
if (errno == 0) { ShowMessage(-Error in ReadFile-);

CornmsTestBAD=True; }
if ('t' != rXChar) { CommsTestBAD=Tr~e;

ShowMessage(-!! !STOPPED!!! !Q)j }
Labell->Caption=rxChar;

/1 Send Get_set_values or 'g' to to put kirlian device into Get setaole
data mode

errno = TransmitCommChar (heam, Get_set_values) j

if (errno == 0) { ShowMessage(-Error in TransrnitCorrmChar
Get_set_values-); CommsTestB~~=True; }

II Calculate correct
voltage_byte
vol':.age_byte

voltage data bits to send
kinfo.getValtage() ;
voltage_byte~8; lithe S highest byt.es sets she

volt.age
Calculate correct. =requency data bits to send

debugging only ra~ove the followi~g line
if ( 0 != kinfo.getFreq~ency(})

fre~eriod = (lOOOOOQ/kinfo_getFrequency()
fre~highbyte=frec--period/OxlJO;

, /:nicroseconds
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fre~lowbyte=fre~eriod - fre~highbyte*Oxl00;

if (fre~lowbyte < 0) fre~highbyte++; /1 for added precision
//Calculate correct expOsure bits to send

switch {int (kinfo.getExposure(»))
(

case 0: exposureChar~Ox09; break;
case 1: exposureChar~OxOA; break;
case 2: exposurechar~OxOC; break;
case 3: exposureChar=Oxll; break;
case 4: exposurechar=Ox12; break;
case 5: exposureChar=Ox14; break;
case 6: exposureChar=Ox21; break;
case 7: exposureChar=Ox22; break;
case 8: exposureChar=0x24; break;
case 9: exposureChar=Ox41; break:
case 10: exposureChar=Qx42: break;
case 11: exposureChar=Ox44; break;
default: ShowMessage(-Incorrect Exposure value received· +

exposureChar) ;
)

sendGetsetBuffer.sprintf (-%c%c%c%c%c%c·, voltage_byte,
fre~lowbyte, fre~highbyte, exposureChar, 'R', 'u'):

errno ; WriteFile (hCom, sendGetsetBuffer.c_str(), 6,
&nBytesWritten, NULL):

if (errno == 0) ( ShowMessage{-Error in TransmitCornmChar .);
CommsTestBAD=True; }

if (PictureRequested)
(

II PollRoutine->Enabled=false;
II Send takePicture or 'p' to take a kirlian picture
errno = TransmitCornmChar {hCom, takePicture};
Labell->Caption=·takePicture~;

if (errno == 0) ShowMessage{·Error in TransmitCommChar
takePicture HV enabled-);

PictureRequested = false;
)

if (errno == 0) ( ShowMessage{-Error in ReadFile")
CommsTestBAD=True; }

II if ('t' != rxChar) CommsTestBAD=True;
ShowMessage(n!! !STOPPED!! !!-); }

} II endelse CommsTestB~~

isTimerRoutineRunning = false;
K200LMain_!->Repaint();

} II end pollroutine
Ii

/'

NE:tl SECTION
2

Kirlian ~xperimenL Template (KET) Values

,,-/

!~ 1) This secLion contains all the KET values
!~ 2) These are all GUl designer components
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/~ 3) Initial setting are configure by the GUI designer */

void __fastcall TK2001Main_f::Template_memoChange{TObject • Sender)
1*·*****·********·**-*******··*·***·*·*···****··_·**·*.*.***- •• *-,,*****

* 2-.1 Executed when user changes the memo Template

*
*
*
*

Arguments:
Effects:
Return:

GUI designer Template memoChanged
Sets the Experiment Template Comment
void

x,,*,,***.**.* •• * •• ***** •• *.*.********.****.* •••••• ** ••• x,,**,,**** •• ***.**
/
(

KETmodified=true;
/lkinfo.setExperimentTemplateComment{ Template_memo->Lines­

>Strings [ 0 ] );
kinfo.setExperimentTemplateComment( Template_memo->Text );

}

/1

void __fastcall TK2QQ1Main_f::Voltage_udClick(TObject • Sender ,
TUDBtnType Button)
f"**"***··****·**·******·*·"···****··"_·************** *****************

* 2.2
click

*

Executed when user changes the voltage via the voltage up down

*
*
*

Arguments:
Effects:
Return:

Voltage Up/Down Button Pressed
Sets the Voltage
void

I
{

}

11

KETmodified=true;
kinfo.setVoltage( Voltage_ud->Position }

void __fastcall TK2001Main_f::Frequency_udClick{TObject * Sender ,
TUDBtnType Button)

*' 2.3
click

Executed when user changes Frequency via the frequency up down

surrounding the Frequency

The counting mechanism re~les on the up down only
COUI'_t.ing is effected by increment/decrement the las"t.

There are unique impla~entation issues
display

a)
b) digit

only
c) The Frequency variable is 10 t.imes the actual frequen~J

dl A label is used ca indicace whether the frequen~J is Hz or kHz

Arguments:
Effects:
Return:

GUI designer Frequency UpiDown 3utton Pressed
Sets the Frequency
void
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Frequency_ud->Increment -= 1;
if (Frequency_ud->Position > 9) Frequency_ud->Increment = 10;
if (Frequency_ud->Position > 99) Frequency_ud->Increment -= 100;
if (Frequency_ud->Position > 999) Frequency_ud->Increment -= 1000;
if (Frequency_ud->Position > 9999) Frequency_ud->Increment = 10000;

/* Exceptions to the above rules */
If Comctrls::btPrev used instead of btPrev because of Ambiguity

switch ( OldFreqValue )
{

case 10: if (Button == Comctrls::btPrev)
{

Frequency_ud->Position = 9;
Frequency_ud->Increment = 1;

} else Frequency_ud->Position 20;
break;

case 100: if (Button == Comctrls::btPrev)
{

Frequency_ud->Pasition = 90;
Frequency_ud->Increment = 10;

} else Frequency_ud->Position = 200;
break;

case 1000: if (Button == Comctrls::btPrev)
{

Frequency_ud->Position = 900;
Frequency_ud->Increment = 100;

} else Frequency_ud->Position = 2000;
break;

case 10000: if (Button == Comctrls::btPrevl
{

Frequency_ud->Position = 9000;
Frequency_ud->Increment = 1000;

} else Frequency_ud->Position = 20000;
break;

default: break;
} / / endswi tch
kinfo.setFrequency(Frequency_ud->Position*lO) ;
OldFreqValue = Frequency_ud->Position;
KETmodified = true;
if (kinfo.getFrequency() > 999)
{

Labe122->Caption = wkHz~;

Frequency_ed->Text = kinfo.getFrequency()/lOOO;
} else
(

Labe122->Caption:;- -Hz";

Frequency_ed->Text = kinfo.getFrequency();

} // endmethod Frequency_udClick
//

void __fas~call TK2001Main_f::Ground_cbxChange(TObject *Sender)

2.4 Executed when user changes the Gro~~d via ~he Ground cornbo box

Argument.s:
Ef::ects:

GUI designer Gra~~d corrbo box Pressed
Sets the Gro~"1d
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KETmodified=true;
kinfo.setGround( Ground_cbx->Itemlndex

void __fastcall TK200~ain_f::Exposure_cbxChange{TObject• Sender)
/***************~*************************************k****************

*
box

*

2.5 Executed when user changes the Exposure via the Exposure combo

*
*
*

Arguments:
Effects:
Return:

GUl designer Exposure combo box Pressed
Sets the Exposure
void

*********************************************************************/

KETmodified=true;
kinfo.setExposure( Exposure_cbx->Itemlndex }

void __fastcall TK2001Main_f::Lens_edChange{TObject ·Sender)
1***************************************************** *****************

*
*

2.6 Executed when user changes the Lens via the Lens edit box

*
*
*

Arguments:
Effects:
Return:

GUI designer Lens edit box Pressed
Sets the Lens
void

KETmodified=true;
kinfo.setLens( Lens_ed->Text

}

11

void __fastcall TK2001Main_f::Focal_udClick(TObject *Sender, TUDBtnType
Button)

2.7 Executed when user changes the Focal length via the Focal up
down click

*

*

Arguments:
Effects;
Return:

Gur designer Focal up down clicked
Sets the Focal length
void

kinfo.setFocal( Focal_ud->position }

void __fastcall TK2001Main_f::Sensitivity_cbxChange(TObject ~Senderj

2.3 Executed when use~ changes the Sensi~ivity via the Sensitivit~

combo box

],--~glllnen1:.S: Gur designer Sensitivity ccrnbo bcx Pressed



*
Effects:
Return:
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Sets the Sensitivity
void

~~****~***************************************************************/

KETmodified=true;
kinfo.setSensitivity {Seusitivity_cbx->ItemIndex}

void __fastcall TK200lMain_f::Experiment_memoChange{TObject *Sender)
1***************************************************** *****************

*
*

2.9 Executed when user changes the Experiment comment

*
*
*

Arguments:
Effects:
Return:

GUl designer Experiment memoChanged
Sets the Experiment Comment
void

KETmodified=true;
kinfo.setPictureComment{ Experiment_memo->Text )

void __fastcall TK2001Main_f::MinTemp_edChange(TObject *Sender)
1***************************************************** *****************

2.10 Executed when user changes the Minimum Temperature

*
* Arguments: GUl designer Minimum Temperature, changed via

textbox or the up/down click
* Effects: Sets the Minimum Temperature
* Return: void

****************************************************************-*****;

KETmodified=true;
kinfo.setMinTemp( MinTemp_ed->Text.ToIntDef(O)

void __fastcall TK2001Main_f::MinAtmPress_edChange(TObject *Sender)

* 2.11 Executed when user changes the Minimum Atmospheric Pressure

*
*

via

*

Arguments:
textbox or the

Effects:
Return:

GUI designer Minimum Atmospheric Pressure,
up/down click

Sets the Minimum Atmosphe=ic Pressure
void

changed

KETmodified=true;
kinfo.setMinPress( MiQ~LmPress_ed~>Text.TolntDef(O: );

void fastcall TR2001Main_~.:MinLight_edChange(TObject ~Sende~)

*
*

2.12 Executed when user changes the Minim~~ ~ight Levels

~ Arguments: GUT designer Minimum ~ight Leve~s, cr-anged via
~ext~ox or the up/down click

Effects: Sets the Minimum ambient Lighc Leve:s



* Return: void
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*********************************************************************/

KETmodified=true;
kinfo.setMinLight( MinLight_ed->Text.TolntDef(O)

}
//

void __fastcall TK2001Main_f::MinHumid_edChange{TObject *Sender)
1***************************************************** *****************

* 2.13 Executed when user changes the Minimum Humidity

*
*

or
*

Arguments: GDr designer Minimum Humidity,
the up/down click

Effects: Sets the Minimum Humidity
Return: void

changed via textbox

KETrnodified=true;
kinfo.setMinHumid( MinHumid_ed->Text.TolntDef{Ol

}

void __fastcall TK2001Main_f::MinObjPress_edChange(TObject ·Sender)
1***************************************************** *****************

*
*

2.14 Executed when user changes the Minimum Object Pressure

* Arguments: GUI designer Minimum Object Pressure, changed via
textbox or the upldown click

* Effects: Sets the Minimum Object Pressure
Return: void

[
KETmodified=true;

kinfo.setMinOpress( MinObjPress_ed->Text.ToIntDef(O)
}

void __fastcall TK2001Main_f::MaxTemp_edChange{TObject *Sender)
1***********************************************************~***~**~***

2.15 Executed when user changes the Maximum T~~erature

* Arguments: GUI designer Maximum Ta~perature, changed via
textbox or the upldown click

* Effects: Sets the Maximum Temperature
Recurn: void

KETmodified=tr~e;

kin£o.secMaxTemp( MaxTemp_ed->Text.ToIntDe£(O)

2.16 Executed when user cb~~ges the M~ximum Acmosp~eric Pressure



via

*

Arguments:
textbox or the

Effects:
Return:
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Gur designer Maximum Atmospheric Pressure,
up/down click

Sets the Maximum Atmospheric Pressure
void

changed

***k**************************************************k***************/

KETmodified=true;
kinfo.setMaxPress( MaxAbmPress_ed->Text.ToIntDef(O)

void _fastcall TK20QlMain_f: : MaxLight_edChange (TObject * Sender}

* 2.17 Executed when user changes the Maximum Light Levels

* Arguments: Gur designer Maximum Light Levels, changed via
textbox or the up/down click

* Effects: Sets the Maximum Light Levels
* Return: void

****************************************************** k***************/

KETmodified=true;
kinfo.setMaxLight( MaxLight_ed->Text.ToIntDef(O)

void __fastcall TKZ001Main_f::MaxHumid_edChangetTObject *Sender)
/**********************************************************************

2.18 Executed when user changes the Maximum Humidity

* Arguments: GUI designer Maximum Humidity, changed via textbox
or the up/down click

* Effects: Sets the Maximum Humidity
* Return: void

KETmodified=true;
kinfo.seWMaxHumid( MaxHumid_ed->Text.ToIntDef{O)

void __fastcall TK2001Main_f::MaxObjPress_edChange(TObject *Sender)
/**********~******~*********~******~*************~*********~*****~**~*~

2.l9 Executed when user changes the Maximum Object Pressure

Fxguments: GUI designer Maximum Object Pressure, changed via
textbax or the up/down click

* E£fec~s: Sets the Ma~imum Object Pressure
* Return; void

KETmodified=true;
kin£o_5e~AxOpress( M~xObjPress_ed->Text.ToIntDef(O)

NETtl SECTION
j'
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Menu Options */

void __fastcall TK2001Main_f::NewExperimentTemplatelClick(TObject
*Sender)
/**********************************************************************
* 3.1 Loads the default experiment template

*
Arguments:

(KET) Clicked
* Effects:
... Return:

GUI designer menu New Kirlian Experiment Template

Sets all the KET values their default values
void

LoadExperimentTemplate(-default-);

void fastcall TK2001Main_f::LoadExperirnentTemplatelClick(TObject
*Sender)
{

/**********************************************************************
* 3.2 Load a previously saved Kirlian experiment template (KET)

* Arguments:
Template Clicked

* Effects:
* Return:

GUI designer menu File -> Load Kirlian Experiment

Opens a dialogue box to load a KET
void

if (OpenDialog->Execute(»
{

FileNameKET = OpenDialog->FileName;
OpenDialog->Options.Contains(ofReadOnly)

KDataOnFile : new TFileStream tOpenDialog->FileName,
fmOpenReadWritelfmShareCompat);

KDataOnFile->Read{&kinfo, sizeof{kinfo}};
KETmodified=false;
delete{KDataOnFile);
BaseDacaDir = FileNameKET.Delete(FileNameKET.LastDelimiter{Q.-)

4) ;

getKDataFilename (); /1 gee the new filename NOT experiment
Template name

DisplayKInfo(kinfo); // Display the new info
}

}

void __fasteall TK2001Main_f::SaveExperimencTemplatelC~ick(TObjecc

""Sender)

, 3.3 Saves the exiscing KE~ values into a user specified ~.ket file

Arguments: GUI designer menu File -> Save Kirlian Experi~en~

Template (KET) Clicked
Effects: Opens a dialogue box co save a ~ET

Return: void
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String str;
TVarRec vrs[l];

if (SaveDialog->Execute(»

if (FileExists{SaveDialog->FileName»
{

str = FmtLoadStr(sOverwrite, OPENARRAY(TVarRec,
(SaveDialog->FileName»);

if (MessageDlg(str, mtConfirmation, TMsgDlgButtons()
« mbYes « mbNo «

mbCancel, 0) !; IDYES)
return;

}

KDataOnFile new TFileStream (SaveDialog->FileName,
fmCreate!fmShareCompat);

KDataOnFile->WriteBuffer(&klnfo, sizeof(kinfo);
1/ Labe126->Caption = Format (W %d save

ARRAYOFCONST«(int)sizeof(kinfo)) I);
FileNameKET = SaveDialog->FileName;
KETmodified=false;
delete (KDataOnFile) i

// Create Data directory
BaseDataDir = FileNameKET.Delete(FileNameKET.LastDelimiter(-.-)

, 4);

if (!CreateDir (BaseDataDir»
{

throw Exception{FileNa~eKET};

}

getKDataFilename (); // get the new filename NOT experiment
Template name

DisplayKlnfo(kinfo}; // Diplay the new info
}

int __fastcall TK2001Main_f::LoadExperimentTemplate{AnsiString
ATemplate)
/***~*************************************~~~**************************

* 3.4 Load che default experiment template

~Iguments: GUI designer menu File -> New Kirlian Experiment:
Template (KET) Clicked

* Effects: Sets all the KET values t~eir default val~es

* Return: void

if (ATemplate =~ ~default:" l

kinfo.setDateTime(j;
kinfo.setPictureFile{Ndefault.bmpN) ;

if Labe127->Caption=kin£o.ge~Pict~reFile();

kinfo.setExperimentTemplateCo~ilent(NPlease e~ter co~~errts

relating t.o overall experiment here!" );
kinfo. secPictureComment {" .-:._ comment about:: t:""le r.his pic!::.lre!");
~info.setVoltage( 21 );
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kin£o.setFrequency( 1000 );
OldFreqValue = kinfo.getFrequency( )/10; /1 No not change this

divison
kinfo.setGround( K_DIRECT );
kinfo.setExposure{ 2 );
kinfo.setLens( -Normal Macro Lens· }i
kinfo".setSensitivity{ 1 );
kinfo.setFocal{ 23 };
kinfo.setFStop( 3 );
kinfo.setMaxTemp( 30 );
kinfo.setMaxPress( 105 );
kinfo.setMaxHumid( 40 );
kinfo.setMaxLight{ SO );
kinfo.se~~ress{ 30 );
kinfo.setMinTemp( 5 );
kinfo.setMinPress{ 45 );
kinfo.setMinHumid{ 0 );
kinfo.setMinLight( 3 );
kinfo.setMinOpress{ 30 );

I 11 endif ATe!!lplate :: "default"
KETmodified=false;
getKDataFilename{) ;
nisplayKInfo{kinfo) ;
return < (int) true);
//method Loa~erimentTemplate

void __fastcall TK2QOIMain_f::Exit_butClick(TObject *Sender)
/************************~*••*******************************~**********

* 3.4 Exit the program gracefully
•

not change else asked user what to do
void

•
•

makes

•

Arguments:
Effects:
up the !<ET

Return:

did

GDr designer Exit Button Clicked
Exit the program immediately if the variables that.

if IKETmodifiedJ
{

if (MessageDlg("Experiment Template is not saved, Still Exit",
mtCon£irmation,

TMsgDIgButtons() « rnbCancel « mbYes , 0) ==
mrYes)

(

11 Yes Pressed Terminate progr~~

Application->Terminate();
else

// Cancelled pressed, return to program
return;

}

else Application->Terminate();
endmethod Exit_outClick

//
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void __fasteall TK200lMain_f::Exit1Click{TObject ~Sender)

* 3.5 Menu handler for Exit Option

*
*
*
*

Arguments:
Effects:
Return:

GUI designer menu: File -> Exit Clicked
calls Exit_butClick
void

Exit_butClick(senderJ;
}

1/

void __fasteall TK200LMain_r::FormClose(TObject *Sender, TCloseAction
&Action)

* 3.6
*

Handler for Main Form X clicked

*
*
*

Arguments:
Effects:
Return:

GUI designer Form X clicked
calls Exit_butClick
void

Exit_butClick{Sender);
}

void __fasteall TK200~in_f::SerialPort2Click{TObjectTSender)
1***************************************************** *****************

* 3.7 Opens a new form showing the serial port selected
* A different serial port can be selected
*
*
*
*

Arguments:
Effects:
Return:

GOl designer menu: Options -> Serial Port Clicked
Opens Serial Port form
void

****.~.*.*.************.*•• ************~*****************************/

PollRoutine->Enabled$falsei
Serial_f->ShowModal();
PollRoutine->Enabled~truei

void __fastcall TK20G1Main_f::StatusBarContextPopuptTObject *Sender,
TPoint &MousePos, bool &Handled)

~ 3.8 Right clicking the Statusbar also brings up the serial port
selection form

SerialPort2Click(Sender)

cornmport __fastcall TK2QOLMain_£::GetCornmPcr~(void)

... 3.9 Get the eurr~qt communication por~ se~ti~g



Arguments:
* Effects:

Communications Port
* Return:
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void
~~ accessor method which returns the

used
The communications port used

return(ActivecommPort) ;

bool __fastcall TK2QOlMain_f::SetCommPort{commport thisPort)
1***************************************************** *****************

* 3.10
•

Set the current Communications port, as specified by the user.

* Arguments:
* Effects:

Communications Port
* Return:

Attempt to set the port to this
A mutator method which attempts

used
true if successful

value
to set the

commport CommPort:thisPort;
DCE dcb;
DWORD dwError;
bool fSuccess;
AnsiString ComStr=-COMS-;
CommsTestBAD=True; /* SetCommPort main objective */

ActiveCommPort=thisPort;
CommsPanel->Color=clRed;
CommsPanel->Caption=·COMMUNICATION STATUS: Still to be tested-;
switch (CommPort)
{

case C, ComStr="COM1" ; break;
case 1, ComStr=" COl'f.2 • ; break;
case 2, ComStr="COM3" ; break;
case 3 : ComStr=" COM4 • ; break;

}

if (heom != INVALID_HANDLE_VALUEl CloseHandle\hCom);
hCam = CreateFile (

ComStr . c_str ( ) ,
GENERIC_READ I GENERIC_WRITE,
0, I~ sharemode: co~m devices muse be opened

w/exclusive-access */

NULL, j* no security aters */

OPEN_EXISTING, /* comm devices roust use this */
0, j* not overlapped I/O */

NULL /* hTemplate NULL for camm devices */

I
if (heam == rNVALID_F~~~LE_VALUE)

dWError = GetLastError();
CommsP~~el->Color=clRed;

CommsPanel->Caption=Farmat{QCOMMUNICATION: Port not Available
ERROR %d-, AR..~YOFCONST(((int)dwError)}); ret.urn(::alse)

!* Omit the ca:l to SetupComm to use t.he default ~~eue sizes.
t~e current configuration. *j

fSuccess = GeeCo~.State(hCcm, &dcz)

.,.. Gee
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&dcb) ;
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if (! fSuccess)
{ / * Handle the error. ., /

CommsPanel->Color=clRed;
CommsPanel->Caption=-COMMUNICATION: Cannot readl Port stateR;

return (false);
} /* Fill the DeS: baud=9600, 8 data bits, no parity, 1 stop bit. */

dcb.BaudRate = 9600; 119600
dcb.ByteSize = 8; //5
dcb.Parity = NOPARITY;
dcb.StopBits = ONESTOPBIT;
fSuccess = SetCommState(hCom,
if {~fSuccess}

{ / * Handle the error. * /
Commspanel->Color=clRed;

CommsPanel->Caption=-COMMUNICATION: Cannot read3 state-;
return «(int)false);

}

1* Timeouts implemented set too 50ms provinsionally*/
COMMTIMEOUTS IpCommTimeouts;
GetCommTimeouts {heam, &lpCommTimeoutsl;
IpCommTimeouts.ReadIntervalTimeout=l;
IpCommTimeouts.ReadTotalTimeoutMultiplier=l;
IpCommTimeouts.ReadTotalTimeoutConstant=5;
IpCommTimeouts.WriteTotalTimeoutMultiplier=l;
IpCommTimeouts.WriteTotalTimeoutConstant=l;
SetCommTimeouts (hCom, &lpCommTimeouts);
//ClearCommError
char received;
DWORD nBytesToRead=l;
DWORD nBytesRead;
//WriteFile (hCom, to_send, nBytesTowrite, &nBytesWritten, NULL);
errno = TransmitCommChar (hCcm, commsCheck};
if (errno == 0) ShowMessage(-Error in TransmitComrr£har 1-);
errno = ReadFile (hCorn, &received, nBytesToRead, &nBytesRead, NULL);
if (errno == Q) ShowMessage{"Error in ReadFile l·);
CommsTestBAD = (received != 'r');
if (CommsTestBAD)

l
CommsPanel->Color=clRed;

CommsPanel->Caption="COMMUNICATION: Kirlian Device not
Responding" ;

} else
{

CommsPanel->Color=clLime;
Commspanel->Caption="COMML~ICATION:Kirlian Responding";

}

return (tr-lle) ;
If endmethod SetComrr~Port

void __fastcall TK2001Main_r::ViewExperimentlClick(TObjecr ~Sender)

!T~~~X~~*~****~*~~**~***~~~***~~*~~~***~~~*~*****~~~*~**~**~~~*~~~~~~~~

~ 3.11 Opens a new form showing previous ~<pe~iments

Arguments:
Effects:
Return:

GDr designer menu: Options -> View 2xperi~e~r Clicked
Opens the Data and Picture Viewer form
void
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*********************************************************************/

PollRoutine->Enabled~false;

SetCurrentDir( BaseDataDir );
DataPictureView_f->ShowModal()
SetCurrentDir( ProgramCurrentDir
PollRoutine->Enabled=true;

void __fastcall TK2001Main_f::EnableHVwithoutCameraClick(TObject
*Sender)
J***************************************************** *****************

* 3.12
*

Toggle the availability of the high voltage system

* Arguments:
Camera Clicked

... Effects:
even though the

*
* Return:

Gut designer menu: Options -> Enable HV without

Toggle the availability of the high voltage system
camera

might not be available
void

********************************************************************/

EnableHVwithoutCamera->Checked = ! (EnableHVwithoutCamera->Checked) ;
}

void __fastcall TK2001Main_f::About1Click(TObject *Sender}
/**********************************************************************

* 3.13 Opens the About form
*
*
*
*

Arguments:
Effects:
Return:

Gur designer menu: Help -> ll-.bout Clicked
Opens the About form
void

PollRoutine->Enabled=false;
AboutBox->ShowModal{};
PollRoutine->Enabled=true;

void __fastcall TK2001Main_f::Help?~outlExecuce(TObject·Sender)

• 3.14 Opens the About form

*

.i\rguments:
Effeccs:
Return:

GUI designer menu: HeIn -> About Clicked
Opens the .;bout form
void

_~outlClick(Sender)

void fastcall
;'-Sender)

'!'K2QOIMain__ . :WhatisKir:ianPhotographylClick;TObjecc

... 3 . .;,.:l

IJe':.ails
Opens a new :o~ showing tnepens a new fo~ snowing ~e:p



GUI designer menu; Help -> What Is Kirlian.... Arguments:
Photography Clicked

,.. Effects:
* Return:
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Opens the WhatIs
void

form

PollRoutine->Enabled=false;
WhatIs_f->ShowModal(} ;
PollRoutine->Enabled=true:
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